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Before You Begin

What is Paint Shop Pro?
Paint Shop Pro is a raster format image editing program, a type of software more 
commonly known as a "bitmap editor". Raster image formats break a picture into a grid of 
equally sized pieces, called pixels, and record color information for each pixel. Common 
examples of raster formats include the Windows ".BMP" format and the CompuServe ".GIF" 
format. 
Unlike most bitmap editors, Paint Shop Pro isn't confined to a short list of raster file 
formats. It provides full support for all of the most popular raster formats, full or partial 
support for many less-popular raster formats, and can read nine meta and vector image 
formats.

Related Topics:
File Formats



TOPIC: Using this Help File



Before You Begin

Using this Help File
For help using Windows Help, click here. 
For help with features specific to Paint Shop Pro Help, see the sections below.

Hypertext Features
Paint Shop Pro Help has a few special hypertext features: 

Tab Jumps
Each topic has a row of tabs across the top, like this one. Each set of tabs groups 
related topics. You can access a topic by clicking on its tab. 
Hypertext Formatting
In the standard Windows Help File format, all hypertext is green. Topic jumps have a 
solid underline, and pop-ups have a dashed underline. In Paint Shop Pro Help, topic 
jumps are red, pop-ups are blue, and jumps to secondary windows are magenta. 

Mouse vs. Keyboard
For most tasks, both mouse and keyboard instructions are provided. 

Mouse instructions are 
preceded by a small diagram of
a mouse...
...Or by a picture of the Toolbar 
button that performs the 
command. 
Keyboard instructions are 
preceded by a small diagram of
a keyboard.

Keyboard Instructions Formatting 
You can access many Windows features and functions from the keyboard by using a 
combination of keystrokes. These combinations are called hot keys, accelerator keys, or
short-cut keys. In Paint Shop Pro Help, the keys you should press appear within angle 
brackets (< >) and a plus sign ("+") connects keys that you should press 
simultaneously. For example, "press <Alt> + <X>" means "hold down the Alt key while 
you press the X key".
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Before You Begin

Technical Support

Most of JASC's Paint Shop Pro technical support calls concern poor image display quality. If 
an image appears grainy or mottled, it's probably because your video display doesn't 
support enough colors to show the image correctly. 

See Color Problems.
The manual and this help file should address the majority of user's questions. For solutions 
to common problems, see Troubleshooting. If we've failed to address your question or 
problem, you can: 

Contact one of the distributors listed in the README.TXT file that is included with Paint 
Shop Pro. 

Contact the developers via CompuServe
 at GO JASC.

Contact the developers at: 
JASC, Inc.

10901 Red Circle Drive, Suite
340

Minnetonka, MN 55343
(612) 930-9171
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Color Functions

 Color Adjustment Functions
 Using Color Adjustment Functions

Paint Shop Pro has five functions for adjusting an image or selection's color. The functions 
all use a similar dialog box and operate in a common manner. The purpose of each function
is explained briefly below. 

The Color Adjustment Functions will work on a selection if the image's color depth is 256 
color grey scale, or greater than 256 colors. With lower color depths, these functions affect 
the entire image.

Brightness / Contrast Function
You use the Brightness/Contrast Function to brighten or darken an entire image or 
selection, or to increase or decrease the range of luminance (contrast) within an image 
or selection. In other words, the Brightness Setting shifts the entire histogram, and the 
Contrast Setting flattens or tightens it. 
Gamma Correct Function
The Gamma Correct Function compensates for any difference in gamma levels between
your computer's monitor and the equipment that originally produced the image. 
Highlight / MidTone / Shadow Function
The Highlight/MidTone/Shadow Function skews an image or selection's luminance. You 
use the function to emphasize highlights or shadows, or to lighten or darken an image 
or selection's mid-range colors. 
Hue / Saturation / Luminance Function
A color can be described by the three characteristics of hue, saturation, and luminance.
Hue describes the color's shade or tint, saturation describes the hue's purity, and 
luminance describes the color's brightness. You can use the Hue/Saturation/Luminance 
Function to modify these three characteristics for the entire image or selection. 
Red / Green / Blue Function
As the name implies, you use the Red/Green/Blue Function to change the levels of red, 
green, and blue in an image or selection. Computer monitors create colors by 
combining red, green, and blue, which are the three primary colors for projected light. 
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 Color Adjustment Functions
 Using Color Adjustment Functions

To use one of the Color Adjustment Functions, follow these steps: 
Select the Image Area
The Color Adjustment Functions will work on a selection if the image's color depth is 
greater than 256 colors. With color depths of 256 or less, these functions affect the 
entire image.

To modify part of an image, select it now. 
To modify the entire image, make sure that there is no selection. 

Select the Function
The five Color Adjustment Functions are explained above. You select a function from 
the Colors Adjust Sub-Menu. Paint Shop Pro will open the Color Adjustment Function 
Dialog Box. 
Set the Function's 
Parameters
You use spin controls to set a Color Adjustment Function's parameters. Any changes 
that you make to the settings will be reflected in the Preview Box. For help with a 
function's settings, click on its name below. 

          Brightness / Contrast Function  
          Gamma Correct Function  
          Highlight / MidTone / Shadow Function  
          Hue / Saturation / Luminance Function  
          Red / Green / Blue Function  

Select the OK Button 
When you have finished adjusting the settings, click on the OK Button, or press 
<Enter>. Paint Shop Pro will modify the image or selection.
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Color Functions

Colorize Function
You use the Colorize Function to convert an image or selection to a uniform hue and 
saturation, while retaining the image or selection's luminance (see Color Definition 
Methods). You can use the function to create sepia tones and other single-color effects. 
Using the Colorize Function is very similar to using one of the Color Adjustment Functions. 
Follow the steps below. 

Select the Image Area
The Colorize Function will work on a selection if the image's color depth is greater than
256 colors. With color depths of 256 or less, the function affects the entire image.

To modify part of an image, select it now. 
To modify the entire image, make sure that there is no selection. 

Access the Colorize Dialog Box 
To access the dialog box, select "Colorize" from the Colors Menu. 
Set the Function's 
Parameters
You use spin controls to set the Colorize Function's parameters. Any changes that you 
make to the settings will be reflected in the Preview Box. 
Select the OK Button 
When you have finished adjusting the settings, click on the OK Button, or press 
<Enter>. Paint Shop Pro will modify the image or selection.
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Color Functions

Grey Scale Function
Converting an image to grey scale replaces each color with a grey of equal luminance. The 
effect is similar to a black-and-white photograph. Converting a 16 million color image to 
grey scale automatically reduces it to 256 colors. You convert an image to grey scale by 
selecting "Grey Scale" from the Colors Menu: 

Click on "Colors" in the 
Menubar, then click on "Grey 
Scale". 
Press <Alt> + <C>, then press 
<G>. 
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Histogram Functions
The Colors Histogram Sub-Menu contains two functions that modify an image or selection 
based upon its histogram. These two functions are explained below. To use one of the 
functions, choose an image or selection, then select the function from the sub-menu. 

The Histogram Functions will work on a selection if the image's color depth is 256 grey 
scale, or greater than 256 colors. With color depths of 256 or less, the functions affect the 
entire image. 
Equalize Histogram Function
The Equalize Histogram Function smoothes out the image or selection's histogram. The 
result is a tempering or averaging of the image or selection's brightness. 
Stretch Histogram Function
If the histogram does not span the entire luminance spectrum    in other words, if the image
does not include both black and white    the Stretch Histogram Function adjusts the image' s
luminance so that it does span the full spectrum. 
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Negative Image Function
Inverting an image or selection replaces each color with its opposite. The effect is similar to
a photographic negative. To invert an image or selection, choose "Negative Image" from 
the Colors Menu: 

Click on "Colors" in the 
Menubar, then click on 
"Negative Image". 
Press <Alt> + <C>, then press 
<N>. 
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Posterize Function
The Posterize Function (pronounced "poster-ize", as in "make it look like a poster") reduces 
the bits per color channel. The lower the bits/channel, the fewer colors the image or 
selection can include. 
Using the Posterize Function is very similar to using one of the Color Adjustment Functions. 
Follow the steps below. 

Select the Image Area
The Posterize Function will work on a selection if the image's color depth is 256 grey 
scale, or greater than 256 colors. With color depths of 256 or less, the function affects 
the entire image.

To modify part of an image, select it now. 
To modify the entire image, make sure that there is no selection. 

Access the Posterize Dialog Box
To access the dialog box, select "Posterize" from the Colors Menu. 
Set the Bits Per Color Channel
You use the Bits/Channel Spin Control to set the bits per color channel. The effect of 
the new setting will be shown in the Preview Box. The preview will show the effect as 
applied to the entire image, even if the image contains a selection. 
Select the OK Button 
When you have finished adjusting the levels, click on the OK Button, or press <Enter>.
Paint Shop Pro will modify the image or selection.
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Color Functions

Solarize Function
The Solarize Function inverts the colors that are above a certain luminance. Using the 
Solarize Function is very similar to using one of the Color Adjustment Functions. Follow the 
steps below. 

Select the Image Area
The Solarize Function will work on a selection if the image's color depth is 256 grey 
scale, or greater than 256 colors. With color depths of 256 or less, the function affects 
the entire image.

To modify part of an image, select it now. 
To modify the entire image, make sure that there is no selection. 

Access the Solarize Dialog Box
To access the dialog box, select "Solarize " from the Colors Menu. 
Set the Solarize Threshold
You use the Threshold Spin Control to set the solarize threshold. The effect of the new 
threshold will be shown in the Preview Box. The preview will show the effect as applied
to the entire image, even if the image contains a selection. 
Select the OK Button 
When you have finished adjusting the threshold, click on the OK Button, or press 
<Enter>. Paint Shop Pro will modify the image or selection.
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Managing Colors

Editing an Image's Color Palette
You edit the current image's color palette from the Color Palette Dialog Box. There are two 
versions of the dialog box: one for 16 color images, and one for 256 color images.

Accessing the Dialog Box
You can access the dialog box by double-clicking on either of the color panels in the 
Select Toolbox, or you can select "Edit Palette" from the Colors Menu. 
Sorting the Palette (256 Colors Only)
You can sort a 256 color palette by palette order, luminance, or hue. You select a sort 
order from the Palette Order Drop Down Box: 
Changing a Color
To change a color, double-click on its square. Paint Shop Pro will open the Color Dialog 
Box. 
Abandoning Your Changes
To return the palette to its original state, undo any changes to its colors, and leave the 
dialog box open, click on the Reset Button, or press <R>. To and abandon your changes
and close the dialog box, click on the Cancel Button, or press <Esc>. 
Saving Your Changes
To close the dialog box and save the edited palette in the active image, click on the OK 
Button, or press <Enter>. If you accessed the Color Palette Dialog Box from the Color 
Controls in the Select Toolbox, the foreground or background color will be set to the 
color that is highlighted in the Color Palette Dialog Box. 
Editing a Color Palette File Using a Text Editor
The Jasc palette file format (".PAL") saves color palette information in a text file format. 
You can edit a PAL file using a text editor, such as Notepad. 
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Loading a Color Palette Into an Image
You can load color palettes into images with color depths of 16 or more. If the color depth 
of the image differs from the color depth of the palette, Paint Shop Pro alters the image to 
match the palette. To load a color palette into the current image, follow these steps: 

Access the Load Palette Dialog Box
To access the dialog box, select "Load Palette" from the Colors Menu. 
Select the Disk Drive
You select a disk drive from the Drive Drop Down Box. 
Select the Directory
You change the directory from the Directories List Box. 
Select the Palette File
You select the file from the File Name List Box. 
Select the Application 
Method
There are three methods for applying the palette to the current image: 

Nearest Color Method
As the name implies, the Nearest Color Method changes each color in the image to
the color in the palette that is the closest match. 
Error Diffusion Method
The Error Diffusion Method attempts to maintain the image's appearance by 
dithering colors that are not in the palette. 
Maintain Indexes Method
The Maintain Indexes Method assigns each color in the palette a sequential index 
number, does the same for the colors in the image, then changes each color in the
image to the like-numbered color in the palette. 

You select a method by choosing its option button. 
Click on the button or its text. 
Press <Alt> plus the option's underlined 
letter.

Select the OK Button 
When you have selected the palette and application method, click on the OK Button, 
or press <Enter>. Paint Shop Pro will modify the image to match the new palette.
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Saving a Color Palette to a Palette File
To save the current image's color palette to a palette file, follow these steps: 

Access the Save Palette Dialog 
Box
To access the dialog box, select "Save Palette" from the Colors Menu. 
Select the Disk Drive
You select a disk drive from the Drive Drop Down Box. 
Select the Directory
You change the directory from the Directories List Box. 
Enter the Filename
You enter a name for the new file by typing over the text in the File Name Text Box. 
Don't worry about the file extension    Paint Shop Pro will add it automatically. 
Select the OK Button 
Click on the OK Button, or press <Enter>. If the filename is already in use, Paint Shop 
Pro will present the Filename In Use Prompt. Click on the Yes Button or press <Enter> 
to overwrite the existing file. 
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Using the Color Dialog Box
You use the Color Dialog Box to select a color from your system's entire color spectrum. You
can access the Color Dialog Box from one of the Color Palette Dialog Boxes, or from the 
Color Tools in the Select Toolbox. The dialog box uses two color definition methods. 
Basic Colors
There are 48 Basic Colors that are preset and cannot be modified. To select a Basic Color: 

Click on the color, then click on the OK Button. 
Press <Alt> + <B>, then use the arrow keys, 
<Home>, and/or <End> to highlight the color. 
When the color is highlighted, press 
<Spacebar>, then press <Enter>. 

Selecting a Custom Color
There are 16 Custom Colors. To select a Custom Color: 

Click on the color, then click on the OK Button. 
Press <Alt> + <C>, then use the arrow keys, 
<Home>, and/or <End> to highlight the color. 
When the color is highlighted, press 
<Spacebar>, then press <Enter>. 

Changing a Custom Color
You change a Custom Color by highlighting it, selecting a Full Spectrum Color, then 
selecting the Add to Custom Colors Button. Follow these steps: 

1 Highlight the Custom Color by clicking on it. With the keyboard, press <Alt> + <C>, 
then use the arrow keys, <Home>, and/or <End> to highlight the color.

2 Select a Full Spectrum Color (see below). 
3 Click on the Add to Custom Colors Button, or press <Alt> + <A>. 

Selecting a Full Spectrum Color with the Mouse
There are two controls for selecting a color with the mouse: the Crosshair Control in the 
large color box, and the Pointer Control for the smaller color box. The controls affect the 
contents of the Color/Solid Display Box. 

Adjusting a Control
You can move the crosshair control or the slide control by dragging them to a new 
location, or you can just click where you want the control to go. 
Color vs. Solid
The hue in the Color half of the Color/Solid Display Box is the setting that is used by 
Paint Shop Pro. If the two differ and you prefer the hue that appears in the Solid side, 
double-click on it. The Color side will be adjusted to match the Solid side. 

Selecting a Full Spectrum Color with the Keyboard
You select a color with a keyboard by typing numbers into the text boxes in the Color 
Dialog Box. Unless you are already familiar with the concepts of computer display color 
creation, and have a specific color in mind, it is considerably easier to select a color using 
the mouse. 



Color vs. Solid
The hue in the Color half of the Color/Solid Display Box is the setting that is used by 
Paint Shop Pro. If the two differ and you prefer the hue that appears in the Solid side, 
press <Alt> + <O>. The Color side will be adjusted to match the Solid side. 
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 Changing an Image's Color Depth
Increasing Color Depth
To increase the number of available colors in the current image, you select the new color 
depth from the Colors Increase Color Depth Sub-Menu: 

Click on "Colors" in the Menubar, click on 
"Increase Color Depth" in the Colors Menu,
then click on the color depth that you want
to use. 
Press <Alt> + <C>, then press <I>, and 
then press the color depth's underlined 
character. 

Decreasing Color Depth
There are up to six different menu selections for decreasing an image's color depth. As you 
may have suspected, how many selections are available depends on the image's current 
color depth. For more help, click on a folder below. 

 Reducing an Image to Two Colors
 Reducing an Image to Sixteen Colors
 Reducing an Image to 256 Colors
 Reducing an Image to 32K or 64K Colors
 Reducing an Image to Between 16 and 257 Colors
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 Changing an Image's Color Depth
 Reducing an Image to Two Colors

To reduce an image to two colors, follow these steps: 
Select 2 Color Reduction
You choose a color reduction level from the Colors Decrease Color Depth Sub-Menu. 
Paint Shop Pro will open the appropriate version of the Decrease Color Depth Dialog 
Box.
Select the Palette
The Palette Option determines which color component will be used to set pixels to 
black or white. For most images, the grey value (or luminance) yields the best results, 
but if an image contains mostly red, green, or blue, then selecting that color 
component will probably be the best choice. For example, images with a lot of flesh 
tones usually reduce better using the red color component. To select a Palette Option: 

Click on the option's button or its 
text. 
Press the option's underlined 
letter. 

Select the Reduction Method
Paint Shop Pro provides three methods for reducing an image to two colors: 

Nearest Color Method
Each pixel is treated independently: any difference between the original color and 
black or white is ignored, so there is no dithering. Yields stark, simple, high-
contrast images. 
Ordered Dither Method
Shading is achieved by patterned dithering. Best suited to certain print mediums. 
Images often appear "hashed", or composed of dots, xshapes, and crosses. 
Error Diffusion Method
Uses dithering to maintain shading. When you select the Error Diffusion Method, 
you must also select of three algorithms: FloydSteinberg, Burkes, or Stucki. Each 
algorithm gives slightly different results. 

You select a method from the Reduction Method Group Box: 
Click on the method's button or its
text. 
Press the method's underlined 
letter. 

Select Palette Weighting 
Option
Weighting the palette sets the image's current colors closer to black and white. This 
results in less dithering, and therefore less shading and sharper edges. Conversely, a 
non-weighted palette yields more dithering, and therefore more shading and softer 
edges. To select a weighting option: 

Click on the option's button or its text. 
Press <W> for weighted or <I> for non-
weighted. 

Select the OK Button 
When you have finished selecting the color reduction options, click on the OK Button, 



or press <Enter>. Paint Shop Pro will close the dialog box and reduce the image's 
color depth. 
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 Changing an Image's Color Depth
 Reducing an Image to Sixteen Colors

To reduce an image to sixteen colors, follow these steps: 
Select the Colors to Boost
An image's less common colors can get all-but-eliminated when you reduce color 
depth. The uncommon colors are often artistically significant, providing the image's 
contrast, or emphasizing its subject. 
To emphasize the significance of a specific color or colors, select a rectangular area in 
the image that contains the colors you want to boost. 
Select 16 Color Reduction
You choose a color reduction level from the Colors Decrease Color Depth Sub-Menu. 
Paint Shop Pro will open the appropriate version of the Decrease Color Depth Dialog 
Box.
Select the Palette
An optimized palette contains the sixteen best colors for recreating the current image.
The Windows palette contains the sixteen colors used by Windows. 
If you will be using the image for display under Windows (as part of an application, in 
a multimedia presentation, etc.), or if you want to create multiple images with the 
same palette, select the Windows Palette Option. Otherwise, choose the Optimized 
Option, because it will yield the best image quality. 
To select a palette option: 

Click on the option's button or its text. 
Press <P> for optimized or <W> for 
Windows. 

Select the Reduction Method
There are three reduction methods: 

Nearest Color Method
As the name implies, the Nearest Color Method changes each color in the image to
the color in the palette that is the closest match. 
Ordered Dither Method
Uses patterned dithering. Best suited to certain print mediums. Images often 
appear "hashed", or composed of dots, xshapes, and crosses. Only available for 
Windows palette. 
Error Diffusion Method
Uses non-patterned, pixel-to-pixel dithering. 

You select a method from the Reduction Method Group Box: 
Click on the method's button or its
text. 
Press the method's underlined 
letter. 

Select the Options
There are two options: 

Boost Marked Colors
Sets the factor by which the colors in the selection are boosted . Only available for 
an optimized palette. 
Reduce Color Bleeding



Reduces the amount of left-to-right color bleeding that occurs when using Error 
Diffusion. 

You select an option from the Options Group Box. If you select the Boost Marked Colors
Option, enter the boost factor into the option's text box. To turn an option on or off: 

Click on the option's check box or its 
text. 
Press the option's underlined letter. 

Select the OK Button 
When you have finished selecting the color reduction options, click on the OK Button, 
or press <Enter>. Paint Shop Pro will close the dialog box and reduce the image's 
color depth. 
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 Changing an Image's Color Depth
 Reducing an Image to 256 Colors

To reduce an image to 256 colors, follow these steps: 
Select the Colors to Boost
An image's less common colors can get all-but-eliminated when you reduce color 
depth. The uncommon colors are often artistically significant, providing the image's 
contrast, or emphasizing its subject. 
To emphasize the significance of a specific color or colors, select a rectangular area in 
the image that contains the colors you want to boost. 
Select 256 Color Reduction
You choose a color reduction level from the Colors Decrease Color Depth Sub-Menu. 
Paint Shop Pro will open the appropriate version of the Decrease Color Depth Dialog 
Box.
Select the Palette
An optimized palette contains the 256 best colors for recreating the current image. 
The standard palette covers the full color spectrum and includes the sixteen Windows 
colors. 
If you want to create multiple images with the same palette, select the Standard 
Palette Option. Otherwise, choose the Optimized Option, because it will yield the best 
image quality. 
To select a palette option: 

Click on the option's button or its text. 
Press <P> for optimized or <S> for 
standard. 

Select the Reduction Method
There are three reduction methods: 

Nearest Color Method
As the name implies, the Nearest Color Method changes each color in the image to
the color in the palette that is the closest match. 
Ordered Dither Method
Uses patterned dithering. Best suited to certain print mediums. Images often 
appear "hashed", or composed of dots, xshapes, and crosses. Only available for 
Windows palette. 
Error Diffusion Method
Uses non-patterned, pixel-to-pixel dithering. 

You select a method from the Reduction Method Group Box: 
Click on the method's button or its
text. 
Press the method's underlined 
letter. 

Select the Options
There are three options: 

Boost Marked Colors
Sets the factor by which the colors in the selection are boosted . Only available for 
optimized palette. 
Include Windows Colors



Adds the sixteen Windows colors to an optimized palette. (Standard palette 
contains the Windows colors by default.) Select this option if you will be using the 
image under Windows running a 256 color display. 
Reduce Color Bleeding
Reduces the amount of left-to-right color bleeding that occurs when using Error 
Diffusion. 

You select an option from the Options Group Box. If you select the Boost Marked Colors
Option, enter the boost factor into the option's text box. To turn an option on or off: 

Click on the option's check box or its 
text. 
Press the option's underlined letter. 

Select the OK Button 
When you have finished selecting the color reduction options, click on the OK Button, 
or press <Enter>. Paint Shop Pro will close the dialog box and reduce the image's 
color depth. 
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 Reducing an Image to 32K or 64K Colors

Images of 32K and 64K color depth (15 bits-per-pixel and 16 bits-per-pixel respectively) are 
handled in memory as 16 million color images (24 bits-per-pixel). This is because Windows 
does not support 15 bits-per-pixel and 16 bits-per-pixel images. The Statusbar will indicate 
that images in these formats can support 16 million colors. 
To reduce an image to 32 or 64 thousand colors, follow these steps: 

Select 32K or 64K Color Reduction
You choose a color reduction level from the Colors Decrease Color Depth Sub-Menu. 
Paint Shop Pro will open the appropriate version of the Decrease Color Depth Dialog 
Box.
Select the Reduction Method
There are two reduction methods: 

Nearest Color Method
As the name implies, the Nearest Color Method changes each color in the image to
the color in the palette that is the closest match. 
Error Diffusion Method
Uses non-patterned, pixel-to-pixel dithering. 

You select a method from the Reduction Method Group Box: 
Click on the method's button or its
text. 
Press the method's underlined 
letter. 

Select the OK Button 
When you have finished selecting the color reduction options, click on the OK Button, 
or press <Enter>. Paint Shop Pro will close the dialog box and reduce the image's 
color depth. 
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To reduce an image to between 16 and 257 colors, follow these steps: 
Select the Colors to Boost
An image's less common colors can get all-but-eliminated when you reduce color 
depth. The uncommon colors are often artistically significant, providing the image's 
contrast, or emphasizing its subject. 
To emphasize the significance of a specific color or colors, select a rectangular area in 
the image that contains the colors you want to boost. 
Select X Colors Reduction
You choose a color reduction level from the Colors Decrease Color Depth Sub-Menu. 
Paint Shop Pro will open the appropriate version of the Decrease Color Depth Dialog 
Box.
Enter the Number of Colors
Type the number of colors that you want the image to contain into the Number of 
Colors Text Box. To access the text box, click in it, or press <Alt> + <U>. 
Select the Reduction Method
There are two reduction methods: 

Nearest Color Method
As the name implies, the Nearest Color Method changes each color in the image to
the color in the palette that is the closest match. 
Error Diffusion Method
Uses non-patterned, pixel-to-pixel dithering. 

You select a method from the Reduction Method Group Box: 
Click on the method's button or its
text. 
Press the method's underlined 
letter. 

Select the Options
There are three options: 

Boost Marked Colors
Sets the factor by which the colors in the selection are boosted . 
Include Windows Colors
Adds the sixteen Windows colors to the image's palette. Select this option if you 
will be using the image under Windows running a 256 color display. 
Reduce Color Bleeding
Reduces the amount of left-to-right color bleeding that occurs when using Error 
Diffusion. 

You select an option from the Options Group Box. If you select the Boost Marked Colors
Option, enter the boost factor into the option's text box. To turn an option on or off: 

Click on the option's check box or its 
text. 
Press the option's underlined letter. 

Select the OK Button 
When you have finished selecting the color reduction options, click on the OK Button, 
or press <Enter>. Paint Shop Pro will close the dialog box and reduce the image's 



color depth. 
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Creating an Empty Image
To create a new, empty image, follow these steps: 

Select the Background 
Color
The new image will be filled with the background color. 
Access the New Image Dialog 
Box
To access the dialog box:

Click on the File New Button.
Select "New" from the File Menu. 
Press <Alt> + <F>, then press 
<N>. 

Set the Width and 
Height
You use the Width and Height Text Boxes to set the new image's dimensions in pixels. 
If the default values are fine, go to the next step. If not:

1 Type the width into the Width Text Box.
2 Press <Tab>.
3 Type the height into the Height Text Box.

Select the Image 
Type
The image type determines the new image's color depth and palette. You select the 
image type from the Image Type Drop Down Box:
Select the OK 
Button
Click on the OK Button, or press <Enter>. Paint Shop Pro will open a new image 
window filled with the background color. 
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Copying an Image
The easiest way to copy an entire image is to select "Duplicate" from the Window Menu: 

Click on "Window" in the 
Menubar, then click on 
"Duplicate". 
Press <Alt> + <W>, then 
press <D>. 

Paint Shop Pro will copy the image to a new image window. 
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 Creating a Screen Capture
 Selecting a Hot Key

You can use the Screen Capture Utility to copy an image from your computer screen into 
Paint Shop Pro. Follow these steps: 

Select the Hot 
Key
If you haven't used the Screen Capture Utility before, you'll need to set the hot key. 
Set the Include Cursor 
Option
To include the cursor in the screen capture, turn the Include Cursor Option on. The 
option is on when a check appears next to "Include Cursor" on the Capture Menu. To 
turn the option on or off, select "Include Cursor".
Choose a Capture 
Type
The capture type determines which area of the screen will be copied. You select one of
the five capture types from the top section of the Capture Menu. 
Go to the Screen 
Area
When you select a capture type, Paint Shop Pro will automatically minimize. Go to the 
application or window that you want to copy from. If you want to copy the whole 
screen, arrange the open applications as you want them to appear in the captured 
image. 
Press the Hot 
Key
Press the Capture Utility's hot key, then follow the directions below for the capture 
type that you selected. Paint Shop Pro will place the captured screen area in a new 
image window.

Full Screen, Client Area, or Window
If the capture type is the full screen, a client area, or a window, Paint Shop Pro will 
copy the area. 

Area
If the capture type is an area, the cursor will change to crosshairs. Point the 
crosshairs at a corner of the area, press and hold the primary mouse button, then 
drag the crosshairs to the opposite corner of the area. Paint Shop Pro will copy the 
area. 

Object
If the capture type is an object, Paint Shop Pro will highlight the current object. 
Move the cursor until the correct object is highlighted, then click once. 
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 Creating a Screen Capture
 Selecting a Hot Key

To select the Screen Capture Utility hot key, follow these steps: 
Access the Capture Setup Dialog 
Box
To access the dialog box, select "Hot Key Setup" from the Capture Menu:
Select the Function 
Key
The screen capture hot key consists of a function key and an optional combination key.
To select a function key:

Click on it in the Hot Key Group 
Box. 
Press <O>, then use the arrow 
keys to highlight a function key. 

Select a Combination Key 
(Optional)
The available combination keys are <Alt>, <Ctrl>, and <Shift>. You select a 
combination key from the bottom of Hot Key Group Box:

Click on it.
Press the key's underlined 
letter. 

Select the OK 
Button 
When you're done, click on the OK Button or press <Enter>. Paint Shop Pro will save 
the hot key definition. 
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Using a TWAIN-Compliant Device (Scanner)
Paint Shop Pro supports TWAIN-compliant image devices, such as scanners. TWAIN is an 
industry standard that allows applications (like Paint Shop Pro) to talk to the software that 
controls an image device. 
TWAIN.DLL and the Image Device Menu Selections
The interface between an application and an image device's software is handled by a file 
named TWAIN.DLL. When you install the software for an image device, a copy of TWAIN.DLL 
is placed in your Windows directory. When Paint Shop Pro starts, it scans your Windows 
directory to see if the file is installed. If it is, the TWAIN-specific menu selections (the File 
Menu's "Acquire" and "Select Source") and the Acquire Image Button are made available. If 
it isn't, the menu selections and Toolbar button are greyed out. 
It is possible to have TWAIN.DLL in your Windows directory without having a TWAIN-
compliant device installed. Some software applications independently install a copy of the 
file, without checking to see if a compliant device is available. Conversely, it also possible 
to have a TWAIN-complaint device attached to your system without having TWAIN.DLL in 
your Windows directory. Some device software installation routines do not automatically 
install TWAIN.DLL. The user must specifically elect to do so. 

If you have a TWAIN-compliant device installed, but "Acquire" and "Select Source" on the 
File Menu are greyed out, check to see if TWAIN.DLL is installed in your Windows directory. If 
it isn't, try reinstalling your device software. Make sure you turn on any options that pertain
to TWAIN drivers. If TWAIN.DLL is still missing, contact the device manufacturer. 
Selecting a TWAIN-Complaint Device
To select a TWAIN-complaint device for acquiring images, choose "Select Source" from the 
File Menu. Paint Shop Pro will tell TWAIN.DLL to open its Select Source Dialog Box. Highlight 
the device that you want to use, then click on the OK Button, or press <Enter>. 
Acquiring an Image
To acquire an image using the selected TWAIN-complaint device, choose "Acquire" from the 
File Menu, or click on the Acquire Image Button in the Toolbar. Paint Shop Pro will tell 
TWAIN.DLL to open the device software's Acquire Dialog Box. For help using the dialog box, 
consult its on-line help or the device software's manual. When the hardware finishes 
processing the image, it will be sent to Paint Shop Pro. 
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Selecting Part of an Image
Selecting part of an image is the first step in a variety of editing tasks. You can copy a 
selection, delete it, alter its colors, apply a filter to it, and more. You create a selection by 
drawing a line around the area that you want to edit. You use one of these four Select Tools 
to draw the line: 

Lasso 
Magic Wand 
Oval Selector 
Rectangle Selector 

Selection Formatting
The line around a selection appears as flashing dashes, which has been described as 
resembling a line of marching ants. In image editing circles, a selection is often referred to 
as "the marquee", because it resembles the flashing lights around a theater marquee. 
Selections and Anti-Aliasing
If the Anti-Alias Selected Area Operations Preference Option is turned on, data that is 
copied using non-rectangular selections will have soft edges. 
Removing a Selection 
You can remove a selection by clicking with the Standard Cursor Tool. If you are using one 
of the Selection Tools , you can remove a selection by clicking anywhere in the image with 
the secondary mouse button. 
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Cut Command
The Cut Command is only available when the active image contains a selection. The Cut 
Command sends the selection to the Windows Clipboard and removes it from the image. 
The resulting hole is filled with the current background color. You can use the Cut 
Command by selecting "Cut" from the Edit Menu, or you can:

Click on the Cut 
Button.
Press <Ctrl> + <X>.

Copy Command
The Copy Command sends the current image or selection to the Windows Clipboard without
affecting the image. You can use the Copy Command by selecting "Copy" from the Edit 
Menu, or you can:

Click on the Copy 
Button.
Press <Ctrl> + <C>.

Clear Command
The Clear Command removes the current image or selection and replaces it with the 
background color. The Clear Command does not send data to the Windows Clipboard. You 
use the command by selecting "Clear" from the Edit Menu:

Click on "Edit" in the Menubar, 
then click on "Clear". 
Press <Alt> + <E>, then press
<L>. 
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Paste Command
The Paste Command retrieves the contents of the Windows Clipboard. There are three ways
to paste data in Paint Shop Pro: 
As a New Image
When you paste data as a new image, Paint Shop Pro opens a new image window and fills 
it with the current data. If the data is in a metafile or vector format, Paint Shop Pro will 
open the Meta Picture Import Dialog Box. To paste as a new image: 

Click on the Paste 
Button.
Press <Ctrl> + <V>.

As a New Selection
When you paste data as a new selection, Paint Shop Pro adds it to the current image and 
defines it as a selection. Follow these steps: 

1 Select the image that you want to paste into. 
2 Select "As New Selection" from the Edit Paste Sub-Menu. 
3 If the data is in a metafile or vector format, Paint Shop Pro will open the Meta Picture 

Import Dialog Box. 
4 Use the mouse to position the selection. When you've got it where you want it, click 

once.
Into the Current Selection
When you paste data into the current selection, Paint Shop Pro replaces the contents of the
selection with the data from the Clipboard. Follow these steps: 

1 Select the image that you want to paste into. 
2 Select the area you want to paste into. 
3 Select "Into Selection" from the Edit Paste Sub-Menu. 
4 If the data is in a metafile or vector format, Paint Shop Pro will open the Meta Picture 

Import Dialog Box. 
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Undo Command
The Undo Command reverses the last edit to the active image. It can remove painting or 
drawing commands, color alterations, filter effects, etc. You can specify how you want Undo
to save data. To use the Undo Command: 

Click on the Undo 
Button.
Press <Ctrl> + <Z>.

Reverting to the Saved File
To abandon all changes made to a file since it was last saved, select "Revert" from the File 
Menu. You will be prompted to confirm you decision. 

To abandon all of your changes and revert to the saved file, click on the Yes Button, or
press <Enter>.

To keep your changes, click on the No Button, or press <N>.
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Empty Clipboard Command
Data that's in the Windows Clipboard resides in your active memory (RAM). And since 
image data is often sizable, this can tie up a considerable amount of memory and slow 
down your system. 
The Empty Clipboard Command solves this problem by clearing the Clipboard of data. To 
use the command, select "Empty Clipboard" from the Edit Menu: 
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Adding Borders to an Image
To add a border to the active image, follow these steps: 

Select the Border 
Color
The borders will use the foreground color. 
Access the Add Borders Dialog 
Box
To access the dialog box, select "Add Borders" from the Image Menu:
Set the Symmetric 
Option
When the Symmetric Option is turned on, the image will have equally-sized borders on
all sides. The option is on when its check box is filled. To turn the option on or off:

Click on the check box or its 
label. 
Press <Alt> + <M>. 

Enter the Border 
Width(s)
How you enter the border widths depends on whether you're using the Symmetric 
Option. 

With Symmetric Option
If you're using the Symmetric Option, enter the width for the borders in the Top 
Text Box. To access the text box, double-click in it, or press <Alt> + <T>. 
Without Symmetric Option
If you're not using the Symmetric Option, enter a width for each border in the 
appropriate text box. To access a text box, double-click in it, or press <Alt> plus 
the text box label's underlined letter. 

Select the OK Button
When you have finished selecting the settings, click on the OK Button, or press 
<Enter>. Paint Shop Pro will add the borders to the image.
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 Cropping an Image
 Enlarging an Image's Area

Cropping an image is like cropping a photograph: you cut off one or more outside edge, 
eliminating unwanted parts of the original graphic. To crop an image: 

1 Use the Rectangle Selector to select the part of the image that you want to retain. The
area outside of the selection will be deleted. 

2 Select "Crop" from the Image Menu. 
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 Cropping an Image
 Enlarging an Image's Area

Enlarging an image's area adds background color around the image, or below it and to the 
right. Follow these steps: 

Select the Background 
Color
The new area will be filled with the background color. 
Access the Enlarge Canvas Dialog 
Box
To access the dialog box, select "Enlarge Canvas" from the Image Menu:
Enter the New Width and 
Height
You enter each of the image area's new dimensions into the appropriate text box. To 
access a text box, click in it, or press <Alt> plus the label's underlined letter. For 
example, to access the Height Text Box, press <Alt> + <H>. 
Set the Center Image 
Option
When the Center Image Option is turned on, the current image is centered in the new 
image area. When the option is turned off, the image appears in the new image area's
upper left corner. The option is on when its check box is filled in, and is off when the 
check is empty. To turn the option on or off: 

Click on the check box or its 
title. 
Press <Alt> + <C>. 

Select the OK Button
When you're done filling in the Enlarge Canvas Dialog Box, click on the OK Button, or 
press <Enter>. Paint Shop Pro will expand the image area. 
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Changing an Image's Width and Height
Paint Shop Pro includes two methods for changing an image's width and height: resampling
and resizing. The two methods are: 

Nearly identical in procedure (the steps you use to achieve the effect). 
Very different in process (the calculations performed by the computer). 
Anything from very similar to very different in results. In most cases, resampling 

produces noticeably superior image quality. 
Resampling Defined
Resampling minimizes the raggedness normally associated with changes in image 
width and height by using a process called "interpolation". As applied here, 
interpolation smoothes out rough spots by estimating how the "missing" pixels should 
appear, and filling them with the appropriate color. 
Resampling is available for grey scale images and images with color depths greater 
than 256. Sixteen color grey scale images are automatically converted to 256 color 
grey scale. If the image you want to edit is not grey scale, and has a color depth of 256 
or less, you can get around this limitation by: 

1 Increasing the image's color depth.
2 Resampling it. 
3 Returning its color depth to the original format. 

Resizing Defined
Resizing duplicates or deletes pixels as necessary to achieve the desired width and 
height. Resizing gives superior results to resampling with simple and hard-edged 
images, and when working with sixteen colors or less. With photo-realistic images, and 
with images that are irregular or complex, try resampling instead. 

Resampling/Resizing Procedure 
To change an image's width and height, follow these steps: 

Access the Appropriate Dialog 
Box
The dialog boxes for the two functions differ only in their titles. You select the function 
that you want to use from the Image Menu. 
Select the New 
Size
You can select one of five standard image sizes, you can specify a custom size by 
width and height, or you can specify a custom size by aspect ratio. 

Standard Sizes
The five standard image sizes are listed in the group box on the left. To select one 
of the standard sizes: 

Click on the option's button or its text. 
Press <Alt> plus the option's underlined 
letter. 

Custom Size by Width and Height
To specify a custom size by width and height in pixels: 

1 Click on the Custom Size Option, or press <Alt> + <U>. 
2 If the Maintain Aspect Ratio Option is turned on (the check box is filled), turn 

it off. Click on the text or check box, or press <Alt> + <M>. 



3 Type the new width into the first text box. 
4 Press <Tab>. 
5 Type the new height into the second text box. 

Custom Size by Aspect Ratio
The aspect ratio is the relationship between the image's two dimensions, 
expressed as width divided by height. To specify a custom size using the aspect 
ratio: 

1 Click on the Custom Size Option, or press <Alt> + <U>. 
2 If the Maintain Aspect Ratio Option is turned off (the check box is empty), 

turn it on. Click on the text or check box, or press <Alt> + <M>. 
3 The Aspect Ratio Text Box will display the image's current aspect ratio. If you

want to change the ratio, double-click in the text box, or press <Alt> + <F>,
then type the new ratio. 

4 Enter the setting for the dimension that you want to fix. For example, if you 
want to fix the width and let the height be determined by the aspect ratio, 
double-click in the Width Text Box and type the new width. 

Select the OK Button
When you're done setting the image's new size and shape, click on the OK Button, or 
press <Enter>. Paint Shop Pro will modify the image to match its new dimensions. 
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Reversing Orientation: Flip and Mirror
The Flip and Mirror Commands reverse an image or selection's orientation along the 
vertical and horizontal axes: 
Flip Command
Reverses the image or selection vertically, so that what was the top becomes the bottom, 
and vice-versa. To use it: 

Select "Flip" from the Image Menu. Click on "Image" in the 
Menubar, then click on "Flip". 
Press <Ctrl> + <F>.

Mirror Command
Reverses the image or selection horizontally, so that what was the left side becomes the 
right side, and vice-versa. To use it: 

Select "Mirror" from the Image Menu. Click on "Image" in the
Menubar, then click on "Mirror". 
Press <Ctrl> + <M>.



Rotating an Image

Rotating an Image
The Rotate Command lets you spin an image by a specified number of degrees. Follow 
these steps: 

Access the Rotate Dialog 
Box
To access the dialog box, select "Rotate" from the Image Menu. 
Select the 
Direction
You select the direction of rotation from the Direction Group Box. Right is clockwise, 
and left is counter-clockwise. To select the direction:

Click on the direction's option button or 
its text. 
Press <Alt> the direction's underlined 
letter.

Select the Degrees
You select the degrees of rotation from the Degrees Group Box:

Click on the appropriate option button or 
its text. 
Press <Alt> the direction's underlined 
letter.

Free Option (Specified Rotation)
The Free Option is only available for 256 color grey scale and 16 million color 
images. Enter the degrees of rotation into the Free Text Box. 

Select the OK Button
When you have finished selecting the settings, click on the OK Button, or press 
<Enter>. Paint Shop Pro will rotate the image.
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Viewing Image Information
The Image Information Dialog Box lists fourteen facts about the active image. The following
table explains each of the data items. To access the dialog box, select "Image Information" 
from the file's Image Window Control Menu: 

Click on the image window's control box, 
then click on "Image Information" in the 
Control Menu. 
Press <Alt> + <->, then press <I>. 

Image Information Data Items
Item Description
Width Image width, in pixels.
Height Image height, in pixels.
Bits Per Pixel Bits-per-pixel of image in memory. 
Max # of Colors Maximum number of colors that image 

supports. Determined by file format. 
Memory Required RAM used by image. 
Source File Name Name of file that contains the original image 

information. 
Source File Type Source file's format. 
Sub Type Source file's sub-format, if any. 
Image can... Indicates if image can be saved to above 

format.
File Is Deletable? Indicates if file can be deleted. Will say "no" 

for files that are read-only, are on read-only 
media (such as CR-ROM), or have not been 
saved. 

Has Been 
Changed?

Indicates if image contains any unsaved 
changes.

Type of Selection Indicates the selection type, if any. Types are 
rectangle, oval, or polygon. 

Undo Buffer 
Location

Indicates memory location for undo buffer. 

Has Mask Channel? Indicates if image has a mask attached. 
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 Applying Deformations and Filters 
Deformations and filters alter an image or selection to achieve a particular effect. 

Deformations create an effect by moving image data from one area to another. As 
the name implies, the result is a deformed version of the original image. 

Filters alter each pixel's color based on its current color and the colors of any 
neighboring pixels. The results can vary widely, from a minor adjustment of a single image 
characteristic (such as luminance), to a wholesale transformation of the image's 
appearance. 
Color Depth
Deformations and filters are available for images with color depths greater than 256 colors,
and for images in 256 color grey scale. To apply a deformation or filter to an image in a 
lower color depth: 

1 Increase its color depth to greater than 256 colors or to 256 color grey scale.
2 Apply the filter or deformation.
3 Reduce the image's color depth to its original format.

Methods
There four ways to apply deformations and filters to images and selections: 

You can select a standard deformation or filter from the Image Menu. 
You can use the Effects Browser to preview and apply deformations and filters. 
You can create and apply your own filters. 
You can apply plugin filters.

 Selecting Effects from the Image Sub-Menus
 Using the Effects Browser



TOPIC: Selecting Effects from the Image Sub-Menus



Deformations and Filters

 Applying Deformations and Filters 
 Selecting Effects from the Image Sub-Menus

The Image Menu contains four standard sub-menus for selecting deformations and filters: 
Deformations
Edge Filters
Normal Filters
Special Filters

To select an effect from one of these sub-menus:
Click on "Image" in the Menubar, click on the sub-menu's name 
in the Image Menu, then click on the effect that you want to 
use. 
Press <Alt> + <I>, then press the underlined letter in the sub-
menu's name, and then press the effect's underlined letter. 

The effect may open a dialog box. Paint Shop Pro's deformations and filters use dialog 
boxes that are similar to the ones used by the Color Functions. For an example, see Using a
Color Adjustment Function. 

 Using the Effects Browser
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 Applying Deformations and Filters 
 Selecting Effects from the Image Sub-Menus 
 Using the Effects Browser

There are two version of the Effects Browser: the Deformation Browser and the Filter 
Browser. To use the Effects Browser, follow these steps: 

Select the Image 
Area
The Circle, Pentagon, Perspective, and Skew Deformations only work on an entire 
image. They cannot be applied to a selection.

To modify part of an image, select it now.
To modify the entire image, make sure that there is no selection. 

Access the Effects Browser Dialog 
Box
You access the dialog box by selecting "Deformation Browser" or "Filter Browser" from 
the Image Menu. 
Select an 
Effect
You select an effect by highlighting it in the list box on the left. Paint Shop Pro will 
preview the effect in the Sample Preview Box on the right. The preview will show the 
effect as applied to the entire image, even if the image contains a selection. To select 
an effect:

Click on it in the list box. Use the scroll bar to 
move through the list. 
Press <Alt> plus the list box label' s 
underlined letter (<F> or <D>), then use the 
cursor keys and/or letter keys to highlight the 
effect. Pressing a letter key moves to the next
effect that begins with that letter. 

Select the Apply 
Button
When you have found the effect that you want to apply, click on the Apply Button, or 
press <Enter>. Paint Shop Pro will apply the effect to the image or selection. If none of
the effects are what you wanted, click on the Cancel Button, or press <Esc>.
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 User-Defined Filters
 Creating a User-Defined Filter

Here's where the real fun begins: Paint Shop Pro 3.0 lets you create your own filters. You 
manage user-defined filters from the Apply User Defined Filter Dialog Box. To access the 
dialog box, select "User Defined Filters" from the Image Menu. 
Filters Explained
A filter alters each pixel's color based on its current color and the colors of any neighboring 
pixels. The heart of a filter is an array of numbers called a filter matrix. Paint Shop Pro uses 
a 5x5 matrix. 
The numbers in the array act as coefficients. When a pixel is processed, its color value is 
multiplied by the coefficient in the array's center, and any pixels within the 5x5 grid are 
multiplied by the corresponding coefficients in the array. The sum of the products becomes 
the target pixel's new value. The new value is saved in a separate bitmap so that it does 
not affect the remaining pixels. 

Simple Filter Calculation Example
The formula for this calculation is:

Where F is the filtered value of the target pixel, P is a pixel in the grid, and C is a coefficient 
in the matrix. 

         Creating a User-Defined Filter  
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 User-Defined Filters
 Creating a User-Defined Filter

Now that you know how a filter works, let's create one. Follow these steps: 
Access the Define New Filter Dialog 
Box
To access the dialog box, click on the New Button in the Apply User Defined Filter 
Dialog Box. 
Enter the Filter 
Name
Type the new filter's name into the Filter Name Text Box. 
Enter the Filter Matrix 
Values
You enter the filter matrix values into the table in the center of the dialog box. Press 
<Tab> to access the first cell and to move through the table. Non-integers will be 
truncated (chopped off at the decimal place). See the next step for help achieving the 
same effect as decimal coefficients. 
Set the Division 
Factor
You can think of the Division Factor as the coefficient denominator: each coefficient in 
the filter matrix is divided by the Division Factor before being applied to a pixel. The 
Division Factor allows you to achieve effects that would otherwise require decimal 
coefficients: 

1 Raise the coefficients to integers by multiplying them by the Division Factor 
(typically 10, 100, or 1000). 

2 Enter the "integer-ized" coefficients in the matrix. 
3 Enter the Division Factor in the Division Factor Text Box. 

When Paint Shop Pro applies the filter, the effect of the coefficients is reduced by the 
Division Factor, and the net result is the same as would have been achieved by the 
original decimal coefficients. 
The advantage of this approach is execution speed: the Division Factor speeds the 
filtering process by allowing Paint Shop Pro to perform its math using integers. In 
actuality, the Division Factor is applied to the product of the matrix calculation. 
The Division Factor changes the filter formula to: 

Where F is the filtered value of the target pixel, P is a pixel in the grid, C is a coefficient
in the matrix, and D is the Division Factor. 
Set the 
Bias
The Bias is added to the product of the matrix calculation and the Division Factor. You 
use the Bias to shift the value of each pixel by a fixed amount. Bias adjustments are 
particularly useful for creating embossing effects. The Bias changes the filter formula 
to: 



Where F is the filtered value of the target pixel, P is a pixel in the grid, C is a coefficient
in the matrix, D is the Division Factor, and B is the Bias. 
Like the other inputs, the Bias must be an integer; non-integers will be truncated. 
Integers outside of the range of 0 to 255 will be converted to fall within the range. For 
example, 256 becomes 0, and -1 is converted to 255. 
Select the OK 
Button 
When you've finished entering the filter's settings, click on the OK Button, or press 
<Enter>. Paint Shop Pro save the filter and return to the Apply User Defined Filter 
Dialog Box. 
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Applying Adobe-Compatible Plugins 
If you have installed Adobe-compatible image processing filters, there will be a Plugins Sub-
Menu at the end of the Image Menu. To select a plugin effect:

Click on "Image" in the Menubar, then click on "Plugins" in the 
Image Menu. The Plugins Sub-Menu may contain effects, more 
sub-menus, or both. Click on a sub-menu to open it, or click on 
an effect to apply it.
Press <Alt> + <I>, then press <G> to open the Plugins Sub-
Menu. underlined letter in the sub-menu's name, and then press
the effect's underlined letter. 

The plugin effect may open a dialog box. For help using it, please consult the plugin's 
documentation or on-line help. For information about plugins and masked images, see 
Enable Internal Plugin Filter Masking. 
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Saving a File
You can save the changes to the current file by selecting "Save" from the File Menu, or you 
can:

Click on the Save File 
Button.

 Press <Ctrl> + <S>. 
If you are saving a new file, Paint Shop Pro will open the File Save As Dialog Box. 



TOPIC: Copying Files



Managing Image Files

Copying Files
There are three ways to copy image files:

You can use the File Save As Dialog Box to save an image under a new filename. 
You can copy an image to a new image window. 
You can use PSP Browser to copy files to a different directory. 
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 Converting a Single File 
 Batch Conversion Utility

You can use the File Save As Dialog Box to save a file in a different format. When you get to
Step 3, select the new format from the File Type Drop Down Box. If the format has sub-
formats, select one from the File Sub-Format Drop Down Box. 
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 Converting a Single File
 Batch Conversion Utility

You use the Batch Conversion Dialog Box to convert multiple image files to a single format. 
Follow these steps:

Access the Batch Conversion Dialog 
Box
To access the dialog box: 

Click on the Batch Conversion 
Button. 
Select "Batch Conversion" from the 
File Menu. Press <Alt> + <F>, then
press <T>. 

Select the Input 
Settings
You select the Input Settings from the Input Group Box. Use the Drive Drop Down Box 
and Directory List Box to select the drive and directory where the files are located. You
can select specific files from the File Name List Box, or you can use the Select All 
Button to execute the conversion . 
Select the Output 
Settings
You select the Output Settings from the Output Group Box. You use the File Type Drop 
Down Box (Example) and the File Sub-Format Drop Down Box to select the file format. 
To select the drive and directory for the new files, click on the Browse Button. Paint 
Shop Pro will open the Select Directory Dialog Box. 
Execute the Batch 
Conversion
If you don't want to see any error messages during the conversion, fill in the Suppress 
Error Messages Check Box. Error messages will still appear in the Batch Processing 
Status Dialog Box. 

To convert the files that you selected in Step 2, click on the OK Button. 
To convert all files in the source directory, click on the Select All Button. 

Paint Shop Pro will begin the batch conversion and will open the Batch Processing 
Status Dialog Box. If you selected any meta/vector, Photo-CD, or RAW files, Paint Shop 
Pro might open the appropriate Image Import Dialog Box



Batch Conversion Dialog Box
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Printing a File
To print a file, follow these steps:

Access the Print Dialog 
Box 
You set the printing options from the Print Dialog Box. To access the dialog box:

Click on the Print Button. 
Select "Print" from the File 
Menu. Press <Alt> + <F>, 
then press <P>. 

Set the Print 
Quality
You set the print resolution from the Print Quality Drop Down Box. The available 
options are determined by the selected printer. For some printers, the Print Quality 
Drop Down Box will be greyed out. 
Enter the Number of Copies 
(Optional)
If your printer supports multiple copies, you can enter the number of copies that you 
want to print into the Copies Text Box. 
Change the Printer or Printer Setup 
(Optional)
The current printer is listed at the top of the Print Dialog Box. If you want to select a 
different printer or change your printer setup, click on the Setup Button, or press 
<Alt> + <S>. 
Change the Page Setup 
(Optional)
If you want to change the current page setup, click on the Page Setup Button, or press
<Alt> + <P>. Paint Shop Pro will open the Page Setup Dialog Box. 
Select the OK 
Button 
Click on the OK Button, or press <Enter>. Paint Shop Pro will send the image file to 
the printer. 
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Closing a Single File
To close a file, follow these steps:

Select the File's Image 
Window

         Selecting an Image Window   
Select the File Close 
Command
You can select "Close" from the File Menu or from the image window's Control Menu, 
or you can:

Double-click on the image window's Control 
Box.
Press <Ctrl> + <F4>.

Respond to the Save File 
Prompt
If you have edited the file and haven't saved it, you will be prompted to do so. 

Closing All Files
To close all open files, select "Close All" from the Window Menu: 

Click on "Window" in the 
Menubar, then click on "Close 
All". 
Press <Alt> + <W>, then press
<A>. 

By default, Paint Shop Pro will prompt you to save any new or edited files. You can use the 
Window Close All Option in under the Saving Tab in the General Preferences Dialog Box to 
turn this prompting on or off. 
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Deleting a File
To delete a file, follow these steps:

Open or Select the 
File

Opening Image Files 
         Selecting an Image Window   

Select the File Delete 
Command
To select the command:

Choose "Delete" from the File Menu. 
Click on "File" in the Menubar, then 
click on "Delete".
Press <Del> or <Delete>. 

Respond to the Delete File 
Prompt
Paint Shop Pro will prompt you to confirm your decision. 
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Opening Images Files
Paint Shop Pro supports a wide range of file formats. There are six ways to open files: 

From the Open Image Dialog Box
From the Most-Recently Used List
Using PSP Browser
From File Manager
Drag-and-Drop from File Manager
From the Command Line 

When You Open a File...
When you open a file, one of two things will happen:

Paint Shop Pro will open the file in a new image window. 
If you selected a meta or vector file, a Photo-CD file, or a RAW file, Paint Shop Pro may

open the appropriate Image Import Dialog Box. 
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Using the Open Image Dialog Box
To open a file using the Open Image Dialog Box, follow these steps:

Access the Open Image Dialog 
Box 
You can access the dialog box by selecting "Open" from the File Menu, or you can:

Click on the File Open 
Button.
Press <Ctrl> + <O>. 

Select the Disk 
Drive
You change the disk drive from the Drive Drop Down Box.
Select the 
Directory
You change the directory from the Directories List Box.
Select the 
Format
You select the file format from the File Type Drop Down Box.
Select the 
File
You select the file from the File Name List Box. 
Check the File Information 
(Optional)
To see information about the file, click on the Information Button, or press <Alt> + 
<I>. Paint Shop Pro will open the File Info Dialog Box, which lists various facts about 
the selected file. For explanations of the data items, see the following table. When 
you're done reviewing the information, click on the OK Button, or press <Enter>. 

Item Description
Disk ID Volume label for a removable medium, such as

a diskette or a CD, where image file is located. 
Directory Drive and directory where image file is located.
File Size File size in bytes. Reflects file compression, if 

any. 
File Date Date and time when file was last saved.
File Type File type or format. 
Version File sub-format, if any. 
Compression Compression type, if any.
Width Image width, in pixels.
Height Image height, in pixels.
Bits Per Plane Bits per color plane. For raster format, reports 

image data. For metafile format, reports video 
display. 

# of Planes Number of color planes. For raster format, 
reports image data. For metafile format, 
reports video display. Reports 1 for non-planar 
raster formats. 

Max # of 
Colors

Maximum number of colors that file format 



supports. 
Unpacked Size Image size in bytes. Uncompressed file size. 

Select the OK 
Button 
Click on the OK Button, or press <Enter>. One of two things will happen:

Paint Shop Pro will open the file in a new image window. 
If you selected a meta or vector file, a Photo-CD file, or a RAW file, Paint Shop Pro may

open the appropriate Image Import Dialog Box. 
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From the Most-Recently Used List
The Most-Recently Used List tracks the four files that have been used most recently by 
Paint Shop Pro. The list appears at the bottom of the File Menu, just below the Exit 
Selection. 

If you have just installed Paint Shop Pro, the Most-Recently Used List will be empty, and the
File Menu will end with the "Exit" selection. 
Selecting a File
To select a file from the Most-Recently Used List: 

Click on it.
Press <Alt> plus the file's underline 
number. For example, to select the first file, 
press <Alt> + <1>. 

When You Open a File...
When you open a file, one of two things will happen:

Paint Shop Pro will open the file in a new image window. 
If you selected a meta or vector file, a Photo-CD file, or a RAW file, Paint Shop Pro may

open the appropriate Image Import Dialog Box. 
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From File Manager
If the file's extension is associated with Paint Shop Pro in File Manager, you can open the 
file by double-clicking on it, or by highlighting it and pressing <Enter>. When you open a 
file, one of two things will happen:

Paint Shop Pro will open the file in a new image window. 
If you selected a meta or vector file, a Photo-CD file, or a RAW file, Paint Shop Pro may

open the appropriate Image Import Dialog Box. 
Getting Help
For more information, see File Manager's on-line help:

Select "Contents" from File Manger's Help Menu. 
Click on "Help" in the File Manager Menubar, then 
click on "Contents". 
Go to File Manager and press <F1>. 
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Dragging-and-Dropping from File Manager
You can "drag" files from File Manager and "drop" them on Paint Shop Pro's Main Window. 
Follow these steps: 

Position the 
Windows
Position the File Manager Main Window and the Paint Shop Pro Main Window so that 
you can see them both. The File Manager Main Window should be "on top" since you 
will use it to "grab" the file. Only a small part of the Paint Shop Pro Main Window in 
fact, just the Titlebar    needs to be visible. 
Find the 
File
Use File Manager to locate the file. For help: 

Select "Contents" from File Manger's Help Menu. Click 
on "Help" in the File Manager Menubar, then click on 
"Contents". 
Press <F1>. 

Grab the 
File
Point at the file's name with your mouse, then press and hold the primary mouse 
button. 
Drag the 
File
Drag the file to the Paint Shop Pro Main Window by moving your mouse. 
Drop the 
File

You can drop the file when the cursor changes to the form shown at right. When it 
does, release the mouse button. The Paint Shop Pro Main Window will move to the 
foreground, and if it recognizes the file format, one of two things will happen: 

Paint Shop Pro will open the file in a new image window. 
If you selected a meta or vector file, a Photo-CD file, or a RAW file, Paint Shop Pro may

open the appropriate Image Import Dialog Box. 
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From the Command Line
You can add filenames to the command line after the Paint Shop Pro executable file. For 
more information, go to Program Manager, select "Run" from the File Menu, and click on 
the Help Button. When you open a file, one of two things will happen:

Paint Shop Pro will open the file in a new image window. 
If you selected a meta or vector file, a Photo-CD file, or a RAW file, Paint Shop Pro may

open the appropriate Image Import Dialog Box. 
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 Starting Paint Shop Pro
You can start Paint Shop Pro from: 

         Program Manager  
         File Manager  
         Command Line  

When you start Paint Shop Pro, one of two things will happen: 
It will open the Main Window. 
You will receive a prompt informing you that your current display settings only 

support sixteen colors. 
 From Program Manager
 From File Manager
 From the Command Line
 Sixteen Color Display
 Exiting Paint Shop Pro
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 Starting Paint Shop Pro
 From Program Manager

Like most Windows applications, you can start Paint Shop Pro by double-clicking on its icon.
The location of the icon depends on how you installed Paint Shop Pro. If you used the 
default setup, the icon is in the Paint Shop Pro group. When you start Paint Shop Pro, one of
two things will happen: 

It will open the Main Window. 
You will receive a prompt informing you that your current display settings only 

support sixteen colors. 
Adding Paint Shop Pro to Program Manager
For help adding Paint Shop Pro to Program Manager, consult your Windows 
documentation. You can also select "New" from Program Manager's File Menu, then click
on the Help Button (or press <H>) in the New Program Object Dialog Box. 

 From File Manager
 From the Command Line
 Sixteen Color Display
 Exiting Paint Shop Pro
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 Starting Paint Shop Pro
 From Program Manager
 From File Manager

You start Paint Shop Pro from File Manager by double-clicking on PSP.EXE, or by highlighting 
it and pressing <Enter>. You'll find PSP.EXE in the drive and directory that you entered 
during installation. If you used the default setup, PSP.EXE is in C:\PSP. When you start Paint 
Shop Pro, one of two things will happen: 

It will open the Main Window. 
You will receive a prompt informing you that your current display settings only 

support sixteen colors. 
 From the Command Line
 Sixteen Color Display
 Exiting Paint Shop Pro
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 Starting Paint Shop Pro
 From Program Manager
 From File Manager
 Command Line

To start Paint Shop Pro from the Windows command line, follow these steps: 
Access the File Run Dialog Box

Select "Run" from the Program Manager's File Menu: 
Click on "File" in the Menubar, then click on "Run". 
Press <Alt> + <F>, then <R>.

Enter Paint Shop Pro's Full Path
Type Paint Shop Pro's drive and directory, followed by "PSP.EXE". If you used the default 
setup, you would type "C:\PSP\PSP.EXE". When you're done, click on the OK Button, or press 
<Enter>. One of two things will happen: 

It will open the Main Window. 
You will receive a prompt informing you that your current display settings only 

support sixteen colors. 
 Sixteen Color Display
 Exiting Paint Shop Pro
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 Starting Paint Shop Pro
 From Program Manager
 From File Manager
 From the Command Line
 Sixteen Color Display

If you run Paint Shop Pro with a sixteen color video display, you'll receive a prompt 
informing you that Paint Shop Pro works best with 256 colors or more. Paint Shop Pro will 
run just fine with a sixteen color display, but images of greater color depth will not look 
their best. 

Most of JASC's Paint Shop Pro technical support calls concern poor image display quality. If 
an image appears grainy or mottled, it's probably because your video display doesn't 
support enough colors to show the image correctly. 

See Color Problems
When you select either of the prompt's buttons, Paint Shop Pro will open the Main Window. 

If you want the prompt to open whenever your system is running a sixteen color 
display driver, click on the Yes Button, or press <Y>. 

If you want to close the prompt permanently, click on the No Button, or press <N>. 
 Exiting Paint Shop Pro
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 Starting Paint Shop Pro
 From Program Manager
 From File Manager
 From the Command Line
 Sixteen Color Display
 Exiting Paint Shop Pro

You exit Paint Shop Pro like most Windows programs. You can:
Select "Exit" from the File Menu. 
Double-click on the Main Window's Control Box.
Press <Alt> + <F4>. 
Select "Exit" from the Main Window's Control Menu. 
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Main Window
Paint Shop Pro's Main Window contains five regions: the Titlebar, the Menubar, the Toolbar, 
the Workspace, and the Statusbar. Each region has specific uses and functions. The Main 
Window also "hosts" image windows and the Tool Windows. 

         Maximize, Minimize, and Restore  
         Moving a Window  
         Resizing a Window  

Main Window Titlebar
The Main Window Titlebar displays "Paint Shop Pro" and contains the standard Windows 
titlebar controls. 

Control Box
At the left end of the Titlebar is the Control Box, which you use to access the Main 
Window Control Menu. Double-clicking on the Control Box closes Paint Shop Pro.
Text Display
Double-clicking on the text display section of a titlebar switches the window between its
maximized and normal states. 
Positioning Buttons
At the right end of the Titlebar are the Main Window's positioning buttons. In the 
diagram of the Titlebar shown here, the Minimize and Maximize Buttons are present. 
When the window is maximized, the Maximize Button is replaced by the Restore Button.

Menubar
The Menubar contains Paint Shop Pro's menus. Each menu lists a "family" of selections, and
each selection performs a specific action. 
Toolbar
Below the Menubar is a row of buttons called the Toolbar. Toolbar buttons perform an 
action, just like a menu selection. Using a Toolbar button couldn't be easier    just click on it.
Workspace
The Workspace is the area between the Toolbar and the Statusbar. As the name implies, 
the Workspace is where you do your work. When you open a file or create a new image, 
Paint Shop Pro opens a new image window within the Workspace. 

Opening Image Files 
         Creating a New Image  
         Working With Image Windows  

Statusbar
The Statusbar appears at the bottom of the Main Window. When you highlight a menu item 
or place the cursor over a Toolbar or Toolbox button, the Statusbar displays information 
about the item or button. When you're working with images, the Satusbar displays 
information about the active image: 

The left panel displays the width, height, and color depth. 
The middle panel displays information about the cursor position. 
The right panel displays: (1) the amount of memory occupied by the image and its 

undo buffer; and (2) the available memory. An image will have an Undo buffer if the Undo 
Storage Option is set to "In Memory". 



Main Window Features
For help with an area of the Main Window, click on it in the diagram below. 



SEARCH: Main Window Features



SEARCH: Main Window Control Box
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Menus
The Menubar contains Paint Shop Pro's menus. Each menu lists a "family" of selections, and
each selection performs a specific action. 
Using the Menus
You open a menu by clicking on it, or by pressing <Alt> plus the letter that is underlined in 
the menu's title. For example, to open the File Menu, you would press <Alt> + <F>. You 
choose a menu selection by clicking on it, by pressing its underlined letter, or by using the 
cursor keys to highlight it and then pressing <Enter>. 
Greyed Out Menus and Selections
Menus and selections that are not currently available appear in grey. When no images are 
open: (1) the Image, Colors, and Window Menus are not available; and (2) about half of the 
selections on the File, Edit, and View Menus are not available. 
Getting Help with a Menu Selection
When you highlight a menu selection, Paint Shop Pro displays a brief description of the 
selection in the Statusbar. If you press <F1>, Paint Shop Pro will open this help file to the 
appropriate topic. To highlight a menu selection: 

Point at the menu's title in the Menubar, then press and
hold the primary mouse button. The menu will open. 
Slide the cursor down the menu to highlight the 
selection that you're interested in. 
Press <Alt> plus the underlined letter to open the 
menu, then use the cursor keys to highlight the 
selection.



TOPIC: Toolbar



Getting Started

Toolbar
Below the Menubar is a row of buttons called the Toolbar. Toolbar buttons perform an 
action, just like a menu selection. Using a Toolbar button couldn't be easier    just click on it.
Greyed Out Buttons
Toolbar buttons that are not currently available appear greyed out. 
Getting Help with a Toolbar Button 
To find out what a Toolbar button does, point at it with the mouse. Paint Shop Pro will 
display a brief explanation of the button's action in the Statusbar. For more help, keep the 
cursor over the button, and press <F1>. Paint Shop Pro will open this help file to the 
appropriate topic. 
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Getting Started

 Toolboxes
 Tool Control Panel

The Toolboxes contain thirty-five tools for image editing. You select a tool from a toolbox by
clicking on its button. The button stays depressed, and the Tool Control Panel displays the 
controls for the selected tool. 

Example: Selecting the Pen Tool

You won't see the changes to the Tool Control Panel if it's hidden. Double-clicking on a tool's
button selects the tool and makes its Tool Control Panel visible. You can also un-hide the 
Tool Control Panel from the View Menu and the Toolbar. 

Related Topics:
         Select Tools  
         Paint Tools   
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Getting Started

 Toolboxes
 Tool Control Panel

When a Select Tool is active, and when three of the Paint Tools are active, the Tool Control 
Panel displays only the Zoom Spin Control. This version of the Tool Control Panel is entitled 
the Zoom Control Panel. 
Most of the Paint Tools use a version of the Tool Control Panel that is unique to the 
particular tool. For help with a specific version of the Tool Control Panel, see the section 
that covers the relevant Paint Tools. 
Although there are many versions of the Tool Control Panel, it only displays two types of 
controls: 

         Spin Controls  
         Drop Down Boxes  
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Using Menus

Making a Selection

Opening a Menu
You open a menu by clicking on it, or by pressing <Alt> plus the letter that is underlined in 
the menu's title. For example, to open the File Menu, press <Alt> + <F>. 
Choosing a Menu Selection
You can choose a menu selection:

By clicking on it. 
By pressing its underlined letter. 
By using the cursor keys to highlight it and then pressing <Enter>. 

Using Sub-Menus
Some menu selections open a "pop-up" menu that appears alongside the parent menu. 
Menu selections that open a sub-menu are followed by a small wedge (" "). You select an 
item from a sub-menu the same way that you select an item from a regular menu: by 
clicking on it, by pressing its underlined letter, or by using the cursor keys to highlight it 
and then pressing <Enter>. 



SEARCH: Menus, Making a Selection
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Using Menus

Getting Help
When you highlight a menu selection, Paint Shop Pro displays a brief description of the 
selection in the Statusbar. To see a menu selection's description: 

Point at the menu's title in the Menubar, then 
press and hold the primary mouse button. The 
menu will open. Slide the cursor down the menu
to highlight the selection that you're interested 
in. 
Press <Alt> plus the underlined letter to open 
the menu, then use the cursor keys to highlight 
the selection.



SEARCH: Menus, Getting Help
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Controlling the Windows

Minimize, Maximize, and Restore
To minimize, maximize, or restore the Main Window or an image window, use the 
Positioning Buttons (see below). The Positioning Buttons appear at the right end of the 
windows titlebar. You can toggle back and forth between the maximized and normal states 
by double-clicking on the text display section of a window's titlebar.



SEARCH: Main Window - Minimize, Maximize, and Restore



 SEARCH: Image Window - Minimize, Maximize, and Restore
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Controlling the Windows

Moving a Window
To move the Main Window, an Image Window, or a Tool Window to a different location: 

Point the cursor at the display portion of the 
titlebar.
Press and hold the primary mouse button.
Drag the window by moving the mouse.
Release the mouse button.



SEARCH: Main Window - Moving



 SEARCH: Image Window - Moving
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Controlling the Windows

Resizing a Window
To change the size of the Main Window or an image window:

Point at a side or corner of the window.
The cursor will change to a double-
headed arrow.
Press and hold the primary mouse 
button.
Resize the window by moving the 
mouse.
Release the mouse button.



SEARCH: Main Window - Resizing



 SEARCH: Image Window - Resizing



HOW TO: Spin Controls, Drop Down Boxes, 
Scrollbars

TOPIC: Using Spin Controls



Using Controls 

Using Spin Controls

You use a spin control to set a numeric property. A spin control consists of a text display 
and two arrow buttons. 

Increase/Decrease by a Single Unit
To increase the property's value by one unit, click on the Up Arrow Button. To 
decrease the value by one unit, click on the Down Arrow Button. 

Increase/Decrease by "Scrolling" Units
To increase or decrease the value by several units or more, point at the appropriate 
arrow button and press and hold the primary mouse button. Release the button when 
you've reached the value that you want.

Entering a Value from the Keyboard
To enter the property's value from the keyboard, double-click in the control's text 
display, then type the new value.
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Using Controls 

Using Drop Down Boxes
You use a drop down box to set a non-
numeric property. To select a setting from a 
drop down box:

Click on the box to open it, then click on the 
value that you want to select. If the entire 
list doesn't fit in the open drop down box, 
use the scroll bar to move through it. 

To access the drop down box, press <Alt> plus the underlined
letter in the drop down boxs label. You use the cursor keys 
and letter keys to highlight a selection. Pressing a letter key 
once moves to the first item that begins with that letter. 
Pressing it again moves to the second.
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Using Controls 

Using Scrollbars
Scroll bars come in two versions, horizontal and vertical. You use them to view text or 
graphics that won't fit in a window, or in some cases, to adjust values. 

Scroll Bar (Example)

You use a scrollbar by moving the slider button. Point at the slider button with the mouse, 
press the primary mouse button, and drag the button in the direction you want to go. 

You can also move the slider button by clicking on either side of it, or by clicking on the 
arrow buttons at either end of the scrollbar. 



HOW TO: Image Import Dialog Boxes
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Image Import Dialog Boxes

There are three file formats that can require additional input before being opened by Paint 
Shop Pro:

Meta / Vector
If you selected a meta or vector file, Paint Shop Pro may open the Meta Picture Import
Dialog Box. 

Photo-CD
If you selected a Photo-CD file, Paint Shop Pro will open the PCD Size Dialog Box. 

RAW 
If you selected a RAW file, Paint Shop Pro will open the RAW Options Dialog Box. 
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Image Import Dialog Boxes

Meta Picture Import Dialog Box
You use the Meta Picture Import Dialog Box to set the size for an image that is in a metafile 
or vector format. Paint Shop Pro will present the dialog box if:

The appropriate header information is missing from a metafile or vector file. 
Under the Metafile / Import Options in the General Preferences Dialog Box, "Ask for 

Size and Options Each Time a File is Opened" is selected. 
You are using the Edit Paste Command to copy meta or vector image data from the 

Windows Clipboard. 
To change the size and scale of the image, you edit the contents of the Width and Height 
Text Boxes. To access a text box, click in it, or press <Tab> until you highlight its text. 
When you're done, click on the OK Button, or press <Enter>. 
Default Import Size
You can change the default import size from the Loading Tab of the General Options Dialog 
Box. 
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Image Import Dialog Boxes

PCD Size Dialog Box
Kodak Photo-CD files contain multiple sizes of a single image. The active Default PCD Size 
Option determines which size will be read when a PCD file is opened. If the last option is 
selected, Paint Shop Pro will present the PCD Size Dialog Box each time you open a PCD file.
To use the dialog box: 

Click on a size option's button or its text, then click on the 
OK Button. 
Press a size option's underlined letter, then press <Enter>. 
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Image Import Dialog Boxes

RAW Options Dialog Box
You use the RAW Options Dialog Box to tell Paint Shop Pro how to interpret RAW pixel data. 
For information about a RAW file's format, refer to the documentation for the application 
that created the image. 
If you are familiar with RAW files, the dialog box should be self-explanatory. If you are new 
to the format, please find and read information about RAW data in general, and about the 
file you are trying to open in particular. A discussion of RAW pixel data is beyond the scope 
of this help file. 



SEARCH: RAW Options Dialog Box
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File Save As Dialog Box
You use the File Save As Dialog Box to save, copy, or convert an image file. Follow these 
steps:

Select the Disk Drive
You change the disk drive from the Drive Drop Down Box.
Select the Directory
You change the directory from the Directories List Box.
Select the Format
You select the file format from the File Type Drop Down Box. If the format has sub-
formats, select one from the File Sub-Format Drop Down Box. 
Enter the Filename
You enter a name for the new file by typing over the text in the File Name Text Box. 
Don't worry about the file extension    Paint Shop Pro will add it automatically. 
Select the OK Button 
Click on the OK Button, or press <Enter>. If the filename is already in use, Paint Shop 
Pro will present the Filename In Use Prompt. Click on the Yes Button or press <Enter> 
to overwrite the existing file. 



SEARCH: File Save As Dialog Box



HOW TO: Selecting an Image Window



Selecting an Image Window
Selecting an Image Window
Only one Image Window can be selected at a time. The currently selected window contains 
the active image, which is the image that any and all editing commands will affect. When 
an Image Window is selected: 

It appears "above" any other Image Windows.
Its titlebar is highlighted.
There is a check next to its filename on the Window Menu.

You can select an Image Window by clicking on it, or you can select its filename from the 
Window Menu. 
When More than Nine Images are Open...
Only nine images can appear on the Window Menu. When more than nine images are open,
you can access the "unlisted" images by selecting "More Windows" from the bottom of the 
Window Menu, and then using the Select Window Dialog Box. 



HOW TO:Basic Color Tasks
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Basic Color Tasks

Selecting the Active Colors
You can select the active colors using the Color Tools, which are grouped at the bottom of 
the Select Toolbox. Double-click on the Foreground Color Panel or the Background Color 
Panel. 

Monochrome Images
Paint Shop Pro will toggle the color. If it's black it will switch to white, and vice-versa. 
16 Color and 256 Color Images
Paint Shop Pro will open the appropriate color palette dialog box. To select a color, click 
on its square, then click on the OK Button. 
16 Million Color Images
Paint Shop Pro will open the Color Dialog Box. 
Reversing the Active Colors
To switch the active colors, so that the foreground color is set to the current background
color and vice-versa, double-click on the Color Reverse Tool. 
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Basic Color Tasks

Counting an Image's Colors
To find out how many colors are actually used in the current image, select "Count Colors 
Used" from the Colors Menu: 

Click on "Colors" in the 
Menubar, then click on "Count
Colors Used". 
Press <Alt> + <C>, then 
press <U>. 

Paint Shop Pro will display the number of colors in a message box. When you're done with 
the message, click on the OK Button or press <Enter>. 



SEARCH: Counting an Image's Colors
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Basic Color Tasks

Increasing an Image's Color Depth
To increase the number of available colors in the current image, you select the new color 
depth from the Colors Increase Color Depth Sub-Menu: 

Click on "Colors" in the Menubar, click on 
"Increase Color Depth" in the Colors Menu,
then click on the color depth that you want
to use. 
Press <Alt> + <C>, then press <I>, and 
then press the color depth's underlined 
character. 



SEARCH: Increasing an Image's Color Depth
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Using the Select Area Dialog Box
You access the Select Area Dialog Box by double-clicking on the Rectangle Selector Button 
or the Oval Selector Button. 
Resizing or Creating a Selection
You set a selection's coordinates in pixels by entering numbers in the four text boxes, then 
clicking on the OK Button or pressing <Enter>. Paint Shop Pro will create or resize the 
selection using the specified coordinates. To access a text box: 

Click in it to edit the current text, or double-click 
to overwrite the text. 
Press <Alt> plus the text box label's underlined 
letter. For example, to access the Top Text Box, 
press <Alt> + <T>.

Changing a Selection's Shape
You can use the Select Area Dialog Box to convert a rectangular selection to an oval 
selection and vice-versa: 

1 If the current selection is a rectangle, double-click on the Oval Selector Button. If the 
current selection is an oval, double-click on the Rectangle Selector Button. 

2 Click on the OK Button, or press <Enter>. 
Saving and Using the Selection Aspect Ratio
When you select the OK Button to close the Select Area Dialog Box (click on it or by press 
<Enter>), Paint Shop Pro saves the current selection aspect ratio (selection width / 
selection height). You can use the saved aspect ratio with the Rectangle Selector and the 
Oval Selector to create selections with identical proportions. 



SEARCH: Select Area Dialog Box
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TOPIC: Using the Select Directory Dialog Box



Using the Select Directory Dialog Box
To use the Select Directory Dialog Box:

1 Select the the disk drive from the Drive Drop Down Box.
2 Select the directory from the Directories List Box.
3 Click on the OK Button, or press <Enter>. 



SEARCH: Select Directory Dialog Box
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Masks

What is a Mask?
You use a mask to apply an editing function (see list below) to an area or areas of an 
image. A mask is a 256 grey scale bitmap that acts something like a stencil. 

A mask is like a stencil in that both have areas that are "open" and areas that are 
"closed". The open areas "let" a function affect the masked image. 

A mask is unlike a stencil in that open and closed are not absolutes: white is 
completely open, black is completely closed, and a shade of grey is a mixture of both. In this
respect, a mask is more like a silk screen: it allows you to achieve different levels of an 
effect within a single image, and during a single "pass" of the function. 

A mask is unlike a stencil in that it will not work with the Paint Tools. You cannot use a
mask to block "paint" from hitting your "canvas". Masks only work with the functions listed 
below. 

Functions that Work with Masks:
         Color Adjustment Functions  
         Colorize Function  
         Negative Image Function  
         Posterize Function  
         Solarize Function  
         Deformations and Filters  
         Flip   
         Mirror  
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Masks

Using Masks
To use a mask, you add it to an image, then perform the function or functions that you 
want the mask to screen. An image that has a mask is called a "host image". When you 
add a mask, you select an image to create the mask from. An image that is used to create 
a mask is called a "source image". A single image can fill both roles. 

         Adding a Mask to an Image  
         Inverting a Mask  
         Deleting a Mask  

Editing Masks
With one exception - the Invert Mask Command - you cannot edit a mask. You can, 
however, create a special kind of source image, called a "mask image", and edit it. This 
allows you to achieve the same results. 

         Creating Mask Images  
         Editing Mask Images  
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Masks

 Adding a Mask to an Image
There are two ways to add a mask to an image: 

You can base the mask on an entire image. 
You can create a mask with a single white area that corresponds to a selection in the 

host image. The rest of the mask will be entirely black. 
 Creating a Mask from an Image
 Creating a Mask from a Selection
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Masks

 Adding a Mask to an Image
 Creating a Mask from an Image

To create a mask from an image, follow these steps: 
Open the Source Image
If the image that you want to create the mask from is closed, open it now. 
Select the Host 
Image
Open or activate the image that you want to attach the mask to. A source image does 
not have to be the same size and dimensions as the host image. If the host image and
the source image are of different width and height, the mask will be automatically 
reshaped to accommodate the host image. 
Access the Add Mask Channel Dialog 
Box
To access the dialog box, select "Add Mask" from the Image Menu. 
Select the Source 
Image
You select the source image from the Source Window Drop Down Box:
Select the Mask 
Type
You select the type of mask from the Create Mask From Group Box. The two whole-
image options are: 

Source Luminance
The Source Luminance Option creates a mask that is a grey-scale copy of the 
entire image. All of the image's luminance is preserved. 
Any Non-Zero Value
The Any Non-Zero Value Option sets all non-black colors to white. The closed areas
of the mask correspond to any pure black areas in the image. If there is not any 
black in the image, then the entire mask will be white. 

To select the mask type: 
Click on the option's button or its text. 
Press <Alt> plus the option's underlined 
letter. 

Set the Invert Mask Data 
Option
Inverting the mask data creates a negative mask: what is black becomes white, what 
is white becomes black, and all other colors are assigned their mirror luminance. The 
Invert Mask Data Option is turned on when its check box is filled. To turn the option on 
or off: 

Click on the check box or its 
label. 
Press <Alt> + <I>. 

Select the OK 
Button 
When you've finished setting the options, click on the OK Button, or press <Enter>. 
Paint Shop Pro will create the new mask, attach it to the active image, and add an "M" 
after the filename in the image window's titlebar. The "M" indicates that a mask is 



attached to the image. 

You are now ready to use any of the mask-compatible functions: 
         Color Adjustment Functions  
         Colorize Function  
         Negative Image Function  
         Posterize Function  
         Solarize Function  
         Deformations and Filters  
         Flip   
         Mirror  
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Masks

 Adding a Mask to an Image
 Creating a Mask from a Selection

You can create a mask from a selection within the host image, but you cannot create a 
mask from a selection in another image. In other words, when you are creating a mask 
from a selection, the host image and the source are one and the same. 
A mask based on a selection has the same dimensions as the entire image. The selection 
becomes a white area in the mask, and the rest of the mask is set to black. (You can use 
the Invert Mask Data Option to reverse this relationship.) If the anti-aliasing preference 
option is turned on, the white area created by the selection will have grey edges of varying 
hues. 
To create a mask from a selection, follow these steps: 

Select the Image 
Area
Select the area that you want to be white in the mask. 
Access the Add Mask Channel Dialog 
Box
To access the dialog box, select "Add Mask" from the Image Menu. 
Choose the Current Selection 
Option
You select the type of mask from the Create Mask From Group Box. To choose the 
Current Selection Option:

Click on the option's button or its
text. 
Press <Alt> + <C>. 

Set the Invert Mask Data 
Option
Inverting the mask data creates a negative mask: the selection area is set to black, 
and the rest of the mask is set to white. The Invert Mask Data Option is turned on 
when its check box is filled. To turn the option on or off: 

Click on the check box or its 
label. 
Press <Alt> + <I>. 

Select the OK 
Button 
When you've finished setting the options, click on the OK Button, or press <Enter>. 
Paint Shop Pro will create the new mask, attach it to the active image, and add an "M" 
after the filename in the image window's titlebar. The "M" indicates that a mask is 
attached to the image. 

You are now ready to use any of the mask-compatible functions: 
         Color Adjustment Functions  
         Colorize Function  
         Negative Image Function  
         Posterize Function  
         Solarize Function  
         Deformations and Filters  
         Flip   



         Mirror  
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Masks

Inverting a Mask
Inverting a mask flips its colors: what was black becomes white, what was white becomes 
black, and shades of grey are assigned their mirror luminance. To invert active image's 
mask, select "Invert Mask" from the Image Menu: 

Click on "Image" in the 
Menubar, then click on "Invert 
Mask". 
Press <Alt> + <I>, then press 
<V>. 

Deleting a Mask
To remove a mask from the active image and permanently delete it, select "Delete Mask" 
from the Image Menu: 

Click on "Image" in the 
Menubar, then click on "Delete
Mask". 
Press <Alt> + <I>, then press
<L>. 
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Masks

Creating Mask Images
A mask image is a standard 256 color grey scale bitmap. You can edit a mask image, use it 
as source image, and achieve the effect of editing the mask itself. There are two ways to 
create a mask image: 

Creating an Empty Mask Image
An empty mask image is a solid black 256 color grey scale bitmap. To create an empty 
mask image with the same size and dimensions as the active image, select "Create 
Empty Mask" from the Image Menu. 
Converting a Mask into a Mask Image
To separate a mask from the active image, select "Split Mask" from the Image Menu. 
Paint Shop Pro will place the mask in a separate image window. You can then edit the 
mask as you would any other image. 

When you create a mask image from a mask, the mask is destroyed. To "reapply" the 
mask, you use the new mask image to create a new mask for its former host. 

Editing Mask Images
A mask image is a standard 256 color grey-scale bitmap, which you can edit just like any 
other image. To edit a mask that is attached to an image, you must separate it first (see 
"Converting a Mask into a Mask Image" above). 
Mask Color Properties
White Completely open. All of a function's effect will pass through the mask and alter the 

corresponding area of an image. 
Black Completely closed. The corresponding area of an image will remain unaltered. 
Grey In-between. Some of the function's effect will pass through the mask and alter the 

corresponding area of an image. The amount that gets through is determined by the 
grey's luminance: a lighter grey lets more effect through, and a darker grey lets less 
through. 
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Customizing Your Setup

Page Setup
You change your page setup from the Page Setup Dialog Box. You can access the dialog box
from the Print Dialog Box, or by selecting "Page Setup" from the File Menu.
Unit of Measure
You can use inches or millimeters as your unit of measure. When you change the units, 
Paint Shop Pro automatically converts all of the measurements in the dialog box. To select a
unit of measure:

Click on it or its option button. 
Press <Alt> plus the unit's underlined 
letter.

Image Scale and Size
To maintain the image's current scale (width/height), turn the Maintain Aspect Ratio on. To 
expand the image so that it will fill the printed page, turn the Use Full Page Option on. 
These options are on when their check boxes are filled. To turn them on or off:

Click on the option's check box or its 
text. 
Press <Alt> plus the option's underlined 
letter. 

If you turn the Use Full Page Option off, you can specify a width and height by entering 
values in the Image Width and Image Height Text Boxes. To access a text box, double-click 
in it, or press <Alt> plus its label's underlined letter. 
Image Position
To center the image on the page, turn the Center On Page Option on. The option is on when
its check box is filled. To turn it on or off:

Click on the option's check box or its 
text. 
Press <Alt> + <P>. 

If you turn the Center On Page Option off, you can specify the image's position by entering 
values in the From Left and From Top Text Boxes. To access a text box, double-click in it, or 
press <Alt> plus its label's underlined letter. 
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Customizing Your Setup

Printer Setup
You change your printer setup from the Print Setup Dialog Box. You can access the dialog 
box from the Print Dialog Box, or by selecting "Printer Setup" from the File Menu.

The name of the Print Setup Dialog Box is a little misleading. You can use the dialog box to 
select any of your system's graphic output devices. These devices are usually printers, but 
can also be another type of device, such as a fax modem. In the interest of simplicity, this 
section will use "printer" to mean any graphic output device.
Selecting a Printer
You can can use any of the other printers that are available to your system. You select a 
printer form the Printer Drop Down Box. 
Setting the Page Orientation
There are two different page orientations, portrait and landscape. On a standard piece of 
stationary paper (8½" by 11" in the U.S.), printing in portrait orientation will place the 
image with its top toward one of the narrower sides, and printing in landscape orientation 
will place the image with its top toward one of the wider sides. To select an orientation: 

Click on its text or option button in the 
Orientation Group Box.
Press <Alt> plus the option's underlined 
letter. 

Selecting the Paper Size and Source
The printer determines which paper size and source options are available. You select the 
size and source from the drop down boxes in the Paper Group Box. (For some printers, one 
or both of the drop down boxes may be unavailable.) 
Other Options
Selecting the Options Button opens a dialog box that is specific to the software or driver 
that operates the selected printer. For help using the dialog box, try pressing <F1>, 
selecting the Help Button (if there is one), or referring to the appropriate documentation. 
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Customizing Your Setup

General Preferences
You change most of Paint Shop Pro's settings from the General Preferences Dialog Box. You 
access the dialog box by selecting "General" from the File Preferences Sub-Menu. 
Using the General Preferences Dialog Box 
The options in the General Preferences Dialog Box are grouped under four tabs. You select 
a tab by clicking on it. Most of the options are controlled by check boxes. To turn a check 
box option on or off:

Click on the option's text or its check 
box.
Press <Alt> plus the option's underlined 
letter.

General Tab Options
Adobe-Compatible Image Processing Filters (Plugins)
Adobe-compatible is the Windows standard for image processing filters. To use Adobe-
compatible filters with Paint Shop Pro: 

1 Fill the Enable Plugins Check Box. 
2 Select the Browse Button. 
3 Use the Select Directory Dialog Box to select the directory that contains the 

filters. 
Enable Internal Plugin Filter Masking
If the Enable Internal Plugin Filter Masking Option is turned on, and a plugin filter is 
applied to an image that has a mask, Paint Shop Pro will run the results of the plugin 
filter through the image's mask. Some plugin filters may work better with this option 
on, and others may require it to be off. For more information, consult the plugin's 
documentation or on-line help. 
Fit Window to Image When Zooming
When this option is turned on, Paint Shop Pro resizes image windows when you zoom in 
or out. A window is resized to include as much of the image as possible. 
Anti-Alias Selected Area Operations
Anti-aliasing smoothes out jagged edges by applying shading to outlying pixels. When 
this option is turned on, Paint Shop Pro applies anti-aliasing to tasks that involve 
selections. 
Close Browser After an Image is Selected
When this option is turned on, PSP Browser will close when you load an image or 
images into Paint Shop Pro. 

Loading Tab Options
Use Aldus-Compatible Import Filters
Aldus-compatible is the Windows standard for file import filters. Paint Shop Pro can use 
Aldus-compatible filters to read additional file formats. To use Aldus-compatible import 
filters with Paint Shop Pro, fill in the check box, and enter the appropriate section 
heading from your WIN.INI file in the text box. For most users, this will be "MS Graphic 
Import Filters".
Metafile / Import Options
There two ways that Paint Shop Pro can open metafiles: (1) it can prompt you for the 



size and other settings when it opens a metafile; or (2) it can try to use the available 
file header information. If you select to use file header information, you need to set the 
default size for files without a header. You use the spin controls to set the dimensions. 

Saving Tab Options
Ask Before Changing...
When an option in this group is turned on, and the specified task is performed, Paint 
Shop Pro will ask for confirmation before it alters an image to accommodate a change in
file format. For example, if the File Save As Option is turned on, and you use the File 
Save As Dialog Box to save an image to a format that does not support the image's 
current color depth: (a) you will be notified that a color depth change is necessary to 
accommodate the new format; and (b) you will be asked to confirm the change. 
Ask to Save Changes...
When an option in this group is turned on, and the specified task is performed, Paint 
Shop Pro will prompt you to save each open file that is new or has been changed. For 
example, if the File Exit Option is turned on, and you close Paint Shop Pro, you will be 
prompted to save every open file that has been edited or has not been saved. 
DPI To Be Written...
These options control the dots-per-inch (DPI) for files saved under the specified formats.
You use the spin controls to change the DPI settings. 
JIF/JPG Compression Level
Controls the amount of compression applied to JIF/JPG files. The higher the number, the 
smaller the files, and the greater the loss of data. 

Misc Tab Options
Default PCD Size
Kodak Photo-CD files contain multiple sizes of a single image. The active Default PCD 
Size Option determines which size will be read when a PCD file is opened. If the last 
option is selected, you will be prompted to select the size each time you open a PCD 
file. 
RAW Save Options
The RAW Save Options control how Paint Shop Pro saves RAW   pixel data  . 
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Customizing Your Setup

New Windows
Paint Shop Pro lets you determine if commands that create a new image should:

Replace the original image with the new image within the current image window 
Leave the original image intact and place the new image in a new window. 

For example, when you apply a deformation or filter, you may want to create a new image 
instead of replacing the existing image. 

When you install Paint Shop Pro 3.0, all commands are set to replace existing images. If 
you installed Version 3.0 over Version 2.0, your old settings were not retained. This is due 
to a necessary change in the underlying technology, and we regret any inconvenience. 
You change the New Window Settings from the New Windows Dialog Box. You access the 
dialog box by selecting "New Windows" from the File Preferences Sub-Menu. 
Understanding the Menu Items
The word before the dash indicates the menu and the text after the dash indicates the 
item. For example, "Image - Resize" is the Resize Selection on the Image Menu. 
Selecting/Deselecting Menu Items
You can set all of the menu items at once, or you can select them individually.

To turn the New Window Option on for all of the menu items, select the All Create 
Button.

To turn the New Window Option off for all of the menu items, select the All Replace 
Button.
To turn the New Window Option on or off for a specific menu item: 

1 Select the menu item from the list box. 
2 Select the appropriate option from the bottom of the dialog box. 
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Undo Storage Options
The Undo Command removes the last set of unsaved changes to an image. You use the File
Preferences Undo Sub-Menu to select if and where Paint Shop Pro should store its backup 
images.

For most users, the "In Memory" setting provides the best results. 
Disabled
If Undo is disabled, Paint Shop Pro does not save backup images. To undo your changes,
use the File Revert Command to retrieve the last saved copy of the file. 
In Memory
When "In Memory" is selected, Paint Shop Pro saves the backup images in RAM, which 
provides the quickest retrieval. If your system is short on memory, or you are working 
with very large, memory-intensive images, this option may prove too demanding. Try 
the "To Disk" setting.
To Disk
When "To Disk" is selected, Paint Shop Pro saves the backup images to the Windows 
temporary directory, which places less demand on your system's memory, but offers 
slower retrieval. If the drive containing your Windows temporary directory is short on 
space, this option may take too long to read and write, and you may encounter 
problems with large image files. 
Selecting an Undo Setting
You select an Undo Setting by clicking on its menu selection, or by pressing the 
appropriate hot keys. The selected setting has a check mark next it on the File 
Preferences Undo Sub-Menu
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Using the Paint Tools

Overview
You use the Paint Tools to create and edit images. The Paint Tools simulate many types of 
painting and drawing utensils, such as brushes, pens, and pencils. For help with one of the 
Paint Tools, click on it in the diagram below. 

Paint Toolbox

Many of the Paint Tool's color effects are only apparent at high color depths. If some of the 
Paint Tools seem to do little or nothing, please confirm that your video display and the 
image you are editing both show 16 million colors. 
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Standard Brush
The Standard Brush Tool simulates painting with an artist's paintbrush. To use the Standard 
Brush:

1 Select the colors that you want to use. 
2 Click on the Standard Brush Button. 
3 Place the cursor where you want to start painting. 
4 Press and hold the primary mouse button to paint with the foreground color. Press and

hold the secondary mouse button to paint with the background color. Paint Shop Pro 
will add color at the cursor. 

5 Move the brush by moving the mouse. 
6 When you're done, release the mouse button. 

Standard Brush Properties
You change the Standard Brush's size and style from the Standard Brush Control Panel. The
Size Spin Control sets the brush's width in pixels. You select the brush's shape from the 
Style Drop Down Box. 
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Clone Brush
You use the Clone Brush to copy part of an image to another location. You can use it to 
copy within a single image, or between two images of the same color depth. To use the 
Clone Brush:

1 Click on the Clone Brush Button. 
2 Place the cursor over the part of the image that you want to copy. 
3 Click once with the secondary mouse button. Your computer will beep once to indicate

that you have selected the source area. 
4 Place the cursor where you want the copy of the source area to appear. This is called 

the target area. The target area can be within the same image, or in another image of
the same color depth. 

5 Press and hold the primary mouse button. Crosshairs will appear over the source area.
The crosshairs indicate which pixel you are copying from. 

6 Move the mouse to copy color from the source area to the target area. 
7 When you're done, release the mouse button. 

Clone Brush Properties
You change the Clone Brush's properties from the Clone Brush Control Panel. 

Size
The Size Spin Control sets the brush's width in pixels. 
Opacity
The Opacity Property determines how opaque or transparent the applied color will be. 
The Opacity Spin Control sets the property on a scale of 1 to 128, with 1 being nearly 
transparent (the applied color will barely appear) and 128 being completely opaque 
(the applied color will completely cover any underlying colors). 
Style
You select the Clone Brush's shape from the Style Drop Down Box. 
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User-Defined Brush
The User-Defined Brush Tool is essentially the Standard Brush with more options. The extra 
properties give you a greater degree of control over the brush's behavior. To "paint" with 
the User-Defined Brush:

1 Select the colors that you want to use. 
2 Click on the User-Defined Brush Button. 
3 Place the cursor where you want to start painting. 
4 Press and hold the primary mouse button to paint with the foreground color. Press and

hold the secondary mouse button to paint with the background color. Paint Shop Pro 
will add color at the cursor. 

5 To add more color, move the brush by moving the mouse. 
6 Release the mouse button. 

User-Defined Brush Properties
You change the User-Defined Brush's properties from the User Brush Control Panel, which 
contains two sets of controls. To switch between the two sets, click on the Right Arrow 
Button or the Left Arrow Button. 

Size
The Size Spin Control sets the tool's width in pixels. If the Size Spin Control is not 
currently visible, click on the Left Arrow Button. 
Opacity
The Opacity Property determines how opaque or transparent the applied color will be. 
The Opacity Spin Control sets the property on a scale of 1 to 128, with 1 being nearly 
transparent (the applied color will barely appear) and 128 being completely opaque 
(the applied color will completely cover any underlying colors). If the Opacity Spin 
Control is not currently visible, click on the Left Arrow Button. 
Style
You select the brush's shape from the Style Drop Down Box. If the Style Drop Down Box 
is not currently visible, click on the Left Arrow Button. 
Fade
The Fade Properly determines the change in opacity from the brush's center to its 
edges. The Fade Spin Control sets the property on a scale of zero to 100, with zero 
being no change in opacity across the brush, and 100 being an opacity of zero 
(complete transparency) at the brush's edges. If the Fade Spin Control is not currently 
visible, click on the Right Arrow Button. 
Density
The Density Property determines how many of the brush's "fibers" make contact with 
the image. In computerese, it determines how many of the tool's pixels are active. The 
Density Spin Control sets the property on a scale of one to 255, with one activating very
few pixels, and 255 activating all of the brush's pixels. If the Density Spin Control is not 
currently visible, click on the Right Arrow Button. 
Movement
The Movement Property determines how the brush responds to the movement of the 
mouse: 

Continuous: Applies color at every pixel along the brush's path. 
Non-Continuous: Applies color when Windows sends a message to Paint Shop Pro 



saying that the mouse has been moved. 
Stepped: Staggers color based on the brush's size. 
Velocity-Sensitive: Applies color less often as 

the mouse moves faster, and more often as it moves slower. 
You select the Movement Property from the Movement Drop Down Box. If the Movement
Drop Down Box is not currently visible, click on the Right Arrow Button. 
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Push Brush
You use the Push Brush to spread colors. The effect is similar to smearing paint, but with 
the Push Brush the color never thins. To use the Push Brush: 

1 Click on the Push Brush Button. 
2 Place the cursor where you want to pick up colors. 
3 Press and hold the primary mouse button. 
4 Move the brush by moving the mouse. The color you picked up will be deposited by 

the brush. 
5 Release the mouse button. 

Push Brush Properties
You change the Push Brush's properties from the Push Brush Control Panel. 

Size
The Size Spin Control sets the brush's width in pixels. 
Strength
The Strength Property determines how much color the Push Brush will deposit. The 
Strength Spin Control sets the property on a scale of 1 to 128, with 1 being almost no 
color and 128 being an exact match of the colors it picked up. 
Style
You select the brush's shape from the Style Drop Down Box. Click on the drop down box 
to open it, then click on the shape that you want. Use the scroll bar to move through 
the list. 
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Airbrush
The Airbrush Tool simulates painting with an airbrush or spray can. To use the Airbrush:

1 Select the colors that you want to use. 
2 Click on the Airbrush Button. 
3 Place the cursor where you want to start painting. 
4 Press and hold the primary mouse button to paint with the foreground color. Press and

hold the secondary mouse button to paint with the background color. Paint Shop Pro 
will add color at the cursor. 

5 To add more color, move the brush by moving the mouse. 
6 Release the mouse button. 

Airbrush Properties
You change the Airbrush's properties from the Airbrush Control Panel. 

Size
The Size Spin Control sets the brush's width in pixels. 
Flow
The Flow Spin Control sets determines how heavily the color is applied (how fast the 
paint is sprayed on). 
Opacity
The Opacity Property determines how opaque or transparent the applied color will be. 
The Opacity Spin Control sets the property on a scale of 1 to 128, with 1 being nearly 
transparent (the applied color will barely appear) and 128 being completely opaque 
(the applied color will completely cover any underlying colors). 
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Fill Tool
You use the Fill Tool to fill an area with a color. The area can be: 

An area filled with a single color or similar colors and bounded by different colors 
and/or the edge of the image. 

A selection that contains a single color or similar colors. 
An area within a selection that contains a single color or similar colors, and is 

bordered by: (a) another color or colors; and (b) part of the selection's boundary. 
To use the Fill Tool, follow these steps: 

1 Set the Fill Tool Tolerance (see below) to the appropriate level. If you're working with 
full-color images (16 million colors), the tolerance level will determine if you do or do 
not fill color blends. 

2 Select the colors that you want to use. 
3 If you're using a selection as all or part of the area's boundaries, make the selection 

now. 
4 Click on the Fill Tool Button. 
5 Place the cursor's crosshairs over a pixel in the area that you want to fill. 
6 Click once with the primary mouse button to fill the area with the foreground color. 

Click once with the secondary mouse button to fill the area with the background color.
Fill Tool Tolerance
The Fill Tool sets the fill area by color. It determines the color of the current pixel, then 
searches for pixels that are within a certain range of that target color. The tolerance setting
determines how closely the color of the pixels it selects must be to the color of the selected
pixel. 
You set the Fill Tool's tolerance from the Tolerance Spin Control on the Fill Tool Control Panel.
The spin control uses a scale of zero to 100, with zero being no tolerance (a perfect color 
match), and 100 being a tolerance of roughly half the spectrum. 
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Pen
The Pen Tool simulates drawing with a ball-point pen. To use the Pen:

1 Select the colors that you want to use. 
2 Click on the Pen Button. 
3 Place the cursor where you want to start drawing. 
4 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. Paint Shop Pro 
will add color at the cursor. 

5 To add more color, move the brush by moving the mouse. 
6 Release the mouse button. 

Pen Properties
You change the Pen's width and shape from the Pen Control Panel. The Size Spin Control 
sets the Pen's width in pixels. You select the Pen's shape from the Style Drop Down Box. 
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Pencil
The Pencil Tool simulates drawing with Pencil. To use the Pencil:

1 Select the colors that you want to use. 
2 Click on the Pencil Button. 
3 Place the cursor where you want to start drawing. 
4 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. Paint Shop Pro 
will add color at the cursor. 

5 To add more color, move the brush by moving the mouse. 
6 Release the mouse button. 

Pencil Properties
You change the Pencil's width and shape from the Pencil Control Panel. The Size Spin 
Control sets the Pencil's width in pixels. You select the Pencil's shape from the Style Drop 
Down Box. 
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Marker
The Marker Tool simulates drawing with a magic marker or felt-tip pen. To use the Marker:

1 Select the colors that you want to use. 
2 Click on the Marker Button. 
3 Place the cursor where you want to start drawing. 
4 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. Paint Shop Pro 
will add color at the cursor. 

5 To add more color, move the brush by moving the mouse. 
6 Release the mouse button. 

Marker Width
You change the Marker's width from the Marker Control Panel. The Width Spin Control sets 
the width in pixels. 
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Crayon
The Crayon Tool simulates drawing with Crayon. To use the Crayon:

1 Select the colors that you want to use. 
2 Click on the Crayon Button. 
3 Place the cursor where you want to start drawing. 
4 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. Paint Shop Pro 
will add color at the cursor. 

5 To add more color, move the brush by moving the mouse. 
6 Release the mouse button. 

Crayon Width
You change the Crayon's width from the Crayon Control Panel. The Width Spin Control sets 
the width in pixels. 
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Chalk
The Chalk Tool simulates drawing with chalk. To use the Chalk Tool:

1 Select the colors that you want to use. 
2 Click on the Chalk Button. 
3 Place the cursor where you want to start drawing. 
4 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. Paint Shop Pro 
will add color at the cursor. 

5 To add more color, move the brush by moving the mouse. 
6 Release the mouse button. 

Chalk Width
You change the Chalk Tool's width from the Chalk Control Panel. The Width Spin Control sets
the width in pixels. 
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Charcoal
The Charcoal Tool simulates drawing with Charcoal. To use the Charcoal:

1 Select the colors that you want to use. 
2 Click on the Charcoal Button. 
3 Place the cursor where you want to start drawing. 
4 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. Paint Shop Pro 
will add color at the cursor. 

5 To add more color, move the brush by moving the mouse. 
6 Release the mouse button. 

Charcoal Width
You change the Charcoal's width from the Charcoal Control Panel. The Width Spin Control 
sets the width in pixels. 
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Swap Brush
You use the Swap Brush to replace one color with another. To use the Swap Brush:

1 Select the colors that you want to use. The Swap Brush can replace the background 
color with the foreground color or vice-versa. 

2 Click on the Swap Brush Button. 
3 Place the cursor where you want to start replacing color. 
4 To replace the background color with the foreground color, press and hold the primary

mouse button. To replace the foreground color with the background color, press and 
hold the secondary mouse button. 

5 Move the mouse to swap the colors. 
6 Release the mouse button. 

Swap Brush Properties
You change the Swap Brush's properties from the Swap Brush Control Panel. 

Size
The Size Spin Control sets the Swap Brush's width in pixels. 
Tolerance
The Tolerance Property determines how close a color must be to the background color 
in order to be replaced. The Tolerance Spin Control uses a scale of zero to 100, with 
zero being no tolerance (a perfect color match), and 100 being a tolerance of roughly 
half the spectrum. 
Style
You select the Swap Brush's shape from the Style Drop Down Box. 
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Undo Brush
You use the Undo Brush to remove the effect of your last action. For example, if you added 
a color over another color, you can "peel back" the new color using the Undo Brush. To use 
the Undo Brush:

1 Click on the Undo Brush Button. 
2 Place the cursor where you want to start removing the effect. 
3 Press and hold the primary mouse button. 
4 Move the mouse to remove the effect. 
5 Release the mouse button. 

Undo Brush Properties
You change the Undo Brush's properties from the Undo Brush Control Panel. 

Size
The Size Spin Control sets the brush's width in pixels. 
Opacity
The Opacity Property determines how much of the effect will be removed. The Opacity 
Spin Control sets the property on a scale of 1 to 128, with 1 leaving the effect almost as
is, and 128 removing all of the effect. 
Style
You select the Undo Brush's shape from the Style Drop Down Box. Click on the drop 
down box to open it, then click on the shape that you want. Use the scroll bar to move 
through the list. 
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Text Tool
You use the Text Tool to add text to an image. Follow these steps:

Select the Text's 
Color
Select the colors that you want to use. The new text will appear in the foreground 
color. If you use the Shadow Effect, it will appear in the background color. 
Select the Text 
Tool
Click on the Text Button in the Paint Toolbox. 
Select the Image
Click anywhere in the image that you're editing. Paint Shop Pro will open the Add Text 
Dialog Box. 
Select the Font 
Properties
The Text Tool supports three font properties: font (typeface), style, and size. You select
the properties from the combo boxes at the top of the dialog box.
Select the Text 
Effects
The Text Tool provides two text effects, strikeout and underline. A text effect is on 
when its check box is filled. 
Select the Special 
Effects
The Text Tool provides three special effects: AntiAlias, Shadow, and Rotate 90 Degrees.
A special effect is on when its check box is filled. 
Enter the 
Text
Enter the text that you want to add to the image in the text box (labeled "Text") at the
bottom of the dialog box. To access the text box, click in it, or press <Alt> + <T>. 
Close the Add Text Dialog 
Box
Click on the OK Button, or press <Enter>. Paint Shop Pro will close the Add Text Dialog
Box. 
Position the 
Text
When the Add Text Dialog Box closes, your cursor will be a four-headed arrow, and the 
text that you entered will be floating behind the cursor. Move the cursor to the place 
where you want the text to appear and click once. Paint Shop Pro will deposit the text 
at the selected spot. 
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Line Tool
You use the Line Tool to draw straight lines. To use the Line Tool: 

1 Select the colors that you want to use. 
2 Click on the Line Button. 
3 Place the cursor where you want to the line to start. 
4 To draw a straight horizontal or vertical line, press and hold <Ctrl> while you 

complete these steps. 
5 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. Paint Shop Pro 
will add color at the cursor. 

6 Drag the cursor to the other end of the line. 
7 Release the mouse button. 

Line Width
You change the Line Tool's width from the Size Spin Control on the Line Tool Control Panel. 
The Width Spin Control sets the width in pixels. 
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Hollow Rectangle Tool
You use the Hollow Rectangle Tool to draw empty boxes. To use the Hollow Rectangle Tool: 

1 Select the colors that you want to use. 
2 Click on the Hollow Rectangle Button. 
3 Point the cursor's upper-left corner where you want one of the rectangle's corners to 

appear. 
4 To draw a square, press and hold <Ctrl> while you complete these steps. 
5 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. 
6 Drag the cursor to the opposite corner of the rectangle. 
7 Release the mouse button. 

Hollow Rectangle Width
You change the width of the Hollow Rectangle's border from the Hollow Rectangle Tool 
Control Panel. The Width Spin Control sets the width in pixels. 
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Solid Rectangle Tool
You use the Solid Rectangle Tool to draw filled rectangles. To use the Solid Rectangle Tool: 

1 Select the colors that you want to use. 
2 Click on the Solid Rectangle Button. 
3 Point the cursor's upper-left corner where you want one of the rectangle's corners to 

appear. 
4 To draw a square, press and hold <Ctrl> while you complete these steps. 
5 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. 
6 Drag the cursor to the opposite corner of the rectangle. 
7 Release the mouse button. 
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Hollow Oval Tool
You use the Hollow Oval Tool to draw empty ovals. To use the Hollow Oval Tool: 

1 Select the colors that you want to use. 
2 Click on the Hollow Oval Button. 
3 Point the cursor's crosshairs at any "corner" of the oval area that you want to draw. 
4 To draw a circle, press and hold <Ctrl> while you complete these steps. 
5 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. 
6 Drag the cursor to the opposite "corner" of the oval. 
7 Release the mouse button. 

Hollow Oval Width
You change the width of the Hollow Oval's border from the Hollow Oval Tool Control Panel. 
The Width Spin Control sets the width in pixels. 
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Solid Oval Tool
You use the Solid Oval Tool to draw filled ovals. To use the Solid Oval Tool: 

1 Select the colors that you want to use. 
2 Click on the Solid Oval Button. 
3 Point the cursor's crosshairs at any "corner" of the oval area that you want to draw. 
4 To draw a circle, press and hold <Ctrl> while you complete these steps. 
5 Press and hold the primary mouse button to draw with the foreground color. Press and

hold the secondary mouse button to draw with the background color. 
6 Drag the cursor to the opposite "corner" of the oval. 
7 Release the mouse button. 
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Smooth Brush
You use the Smooth Brush to soften or blur edges and contrasts. To use the Smooth Brush: 

1 It's generally a good idea to zoom in on the part of the image that you want to soften. 
2 Click on the Smooth Brush Button. 
3 Press and hold the primary mouse button. 
4 Move the brush over the area by moving the mouse. Repeat until you achieve the 

desired effect. If it's not happening fast enough, increase the Strength Setting (see 
below) and start over at Step 3. 

5 Release the mouse button. 
Smooth Brush Properties
You change the Smooth Brush's properties from the Smooth Brush Control Panel. 

Size
The Size Spin Control sets the brush's width in pixels. 
Strength
The Strength Property determines how powerful the Smooth Brush's effect will be. The 
Strength Spin Control sets the property on a scale of 1 to 128, with 1 having almost no 
effect and 128 being a pronounced and rapid blurring of details. 
Style
You select the brush's shape from the Style Drop Down Box. Click on the drop down box 
to open it, then click on the shape that you want. Use the scroll bar to move through 
the list. 
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Sharpen Brush
You use the Sharpen Brush to heighten and accentuate edges and contrasts. To use the 
Sharpen Brush: 

1 It's generally a good idea to zoom in on the part of the image that you want to 
sharpen. 

2 Click on the Sharpen Brush Button. 
3 Press and hold the primary mouse button. 
4 Move the brush over the area by moving the mouse. Repeat until you achieve the 

desired effect. If it's not happening fast enough, increase the Strength Setting and 
start over at Step 3. 

5 Release the mouse button. 
Sharpen Brush Properties
You change the Sharpen Brush's properties from the Sharpen Brush Control Panel. 

Size
The Size Spin Control sets the brush's width in pixels. 
Strength
The Strength Property determines how powerful the Sharpen Brush's effect will be. The 
Strength Spin Control sets the property on a scale of 1 to 128, with 1 being almost no 
effect and 128 being a pronounced and rapid increase in edges and contrasts.  
Style
You select the brush's shape from the Style Drop Down Box. 
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Overview
For help with one of the Select Tools, click on it in the diagram below. 

Select Toolbox
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Standard Cursor Tool
The Standard Cursor Tool returns your cursor to its default state. If you click on an image 
that contains a selection, the Standard Cursor Tool will deactivate the selection. 
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Color Selector
You use the Color Selector to set an active color by clicking on part of an image. To use the 
Color Selector: 

1 Click on the Color Selector Button. 
2 Point the eye dropper's tip at the color you want to select. The middle panel of the 

Statusbar will display the color's RGB values. In palletized images, the Statusbar 
displays the color's palette index before its RGB values. 

3 Click once with the primary mouse button to select the foreground color. Click with 
the secondary mouse button to select the background color. 
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Magnifier 
When you click on the Magnifier Button, the cursor changes to a small magnifying glass. 
Zooming In
Clicking on an image with the primary mouse button increases the magnification factor by 
one level. If you start at 1:1, clicking once will take you to 2:1. 
Zooming Out
Clicking on an image with the secondary mouse button (the button you use less often) 
decreases the magnification factor by one level. If you start at 1:1, clicking once will take 
you to 1:2.
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Image Mover
You use the Image Mover to scroll through the image area when the entire image is not 
visible. To use the Image Mover:

1 Click on the Image Mover Button. 
2 Place the hand-shaped cursor over the image area. 
3 Press and hold the primary mouse button. 
4 Drag the image by moving the mouse. 
5 Release the mouse button. 
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Rectangle Selector 
You use the Rectangle Selector to select rectangular areas. There are two ways to use this 
tool: you can draw the rectangle, or you can specify it numerically. Once you have made a 
selection, you can use the Selection Adjuster to modify it. 
Drawing a Rectangular Selection
To draw a rectangle with the mouse, follow these steps: 

1 Click on the Rectangle Selector Button. 
2 Point the cursor's crosshairs at any corner of the rectangular area that you want to 

select. 
3 To select a square, press and hold <Ctrl> while you finish these steps. To use the 

saved aspect ratio (width / height), press and hold <Shift>. 
4 Press and hold the primary mouse button. 
5 Drag the cursor to the opposite corner of the rectangle. 
6 Release the mouse button.

Specifying a Rectangular Selection Numerically
Double-clicking on the Rectangle Selector Button accesses the Select Area Dialog Box. You 
use the dialog box to specify a selection by entering X and Y pixel coordinates. 
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Oval Selector
You use the Oval Selector to select oval areas. There are two ways to use this tool: you can 
draw the oval, or you can specify it numerically. Once you have made a selection, you can 
use the Selection Adjuster to modify it. 
Drawing an Oval Selection 
To draw an oval with the mouse, follow these steps: 

1 Click on the Oval Selector Button. 
2 Point the cursor's crosshairs at any "corner" of the oval area that you want to select.
3 To select a circle, press and hold <Ctrl> while you finish these steps. To use the saved

aspect ratio (width / height), press and hold <Shift>. 
4 Press and hold the primary mouse button. 
5 Drag the cursor to the opposite "corner" of the oval. 
6 Release the mouse button.

Specifying an Oval Selection Numerically
Double-clicking on the Oval Selector Button accesses the Select Area Dialog Box. You use 
the dialog box to specify a selection by entering x and y pixel coordinates. 
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Selection Adjuster 
You use the Selection Adjuster to move or resize a selection. 
Moving a Selection
When you move a selection, you are not moving the selected image data. Instead, you are 
changing what part of the image is selected. To move a selection, follow these steps:

1 Click on the Selection Adjuster Button. 
2 Point at the middle of the selection. The cursor will change to a four-headed arrow.
3 Press and hold the primary mouse button. 
4 Drag the selection to its new location. 
5 Release the mouse button.

Resizing a Selection
You cannot resize selections made with the Lasso Tool or the Magic Wand. You can only 
resize selections made with the Rectangle Selector and the Oval Selector. 
When you resize a selection, you move a side or corner so that the selection includes a 
different portion of the image. Moving a corner repositions two sides of the selection at 
once. To resize a selection, follow these steps:

1 Click on the Selection Adjuster Button. 
2 Point at a side or corner of the selection. The cursor will change to a two-headed 

arrow. The "corners" of an oval selection are located where the corners of a rectangle 
with equal height and width would appear.

3 Press and hold the primary mouse button. 
4 Drag the border or corner to its new location. 
5 Release the mouse button.
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Cloner
You use the Cloner to copy a selection's contents to another location in the image. Follow 
these steps: 

1 Click on the Cloner Button. 
2 Place the cursor over the selection. 
3 Press and hold the primary mouse button. 
4 Drag the selection by moving the mouse. 
5 Release the mouse button. Paint Shop Pro will copy the selection's contents to the 

new location.
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Lasso
You use the Lasso to make a freehand selection. A freehand selection can be any shape 
that you can draw with the mouse. To use the Lasso:

1 Click on the Lasso Button. 
2 Point the cursor's crosshairs at any point along the boundary of the area that you 

want to select. 
3 Press and hold the primary mouse button. 
4 Drag the cursor to draw the selection's boundary. The boundary can cross itself. The 

selection will contain any image data that is within an area enclosed by the 
boundary . 

5 Release the mouse button. If you haven't "closed" the selection, Paint Shop Pro will 
add a straight line between the selection's starting and ending points.
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Magic Wand
You can use the Magic Wand to select an area of similar or matching color, or to select an 
area that is bounded by a single color or by similar colors. 
Using the Magic Wand
To use the Magic Wand:

1 If the object you're trying to select is small, try zooming in until it's clearly visible. 
2 Click on the Magic Wand Button. 
3 Point the cursor at the object that you want to select. 
4 Click once with the primary mouse button. 
5 If the Magic Wand didn't select the object you wanted, try repositioning the cursor. If 

that doesn't work, try adjusting the Wand's tolerance. 
Setting the Magic Wand Tolerance
The Magic Wand locates image objects by color. It determines the color of the current pixel,
then searches for pixels that are within a certain range of that target color. The tolerance 
setting determines how closely the color of the pixels it selects must be to the color of the 
selected pixel. 
To set the tolerance, start by double-clicking on the Magic Wand Button. Paint Shop Pro will 
present the Magic Wand Dialog Box. You use the Tolerance Spin Control to change the 
tolerance setting. The spin control uses a scale of zero to 100, with zero being no tolerance
(a perfect color match), and 100 being a tolerance of roughly half the spectrum. 
When the Tolerance Text Box displays the setting that you want, click on the OK Button, or 
press <Enter>. 
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Color Tools
You can select the active colors using the Color Tools, which are grouped at the bottom of 
the Select Toolbox. 
Selecting an Active Color
To select an active color from the current image's available colors, double-click on the 
Foreground Color Panel or the Background Color Panel. 

Monochrome Images
Paint Shop Pro will toggle the color. If it's black it will switch to white, and vice-versa. 
16 Color and 256 Color Images
Paint Shop Pro will open the appropriate color palette dialog box. To select a color, click 
on its square, then click on the OK Button. 
16 Million Color Images
Paint Shop Pro will open the Color Dialog Box. 

Reversing the Active Colors
To switch the active colors, so that the foreground color is set to the current background 
color and vice-versa, double-click on the Color Reverse Tool. 
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Working with Image Windows
When you open a file or create a file, Paint Shop Pro displays the image in an Image 
Window. Image windows appear within the Workspace. 
Positioning an Image Window
You can position an Image Window within the workspace just like you position the Main 
Window within the Windows desktop. 

         Maxmize, Minimize, and Restore  
         Moving a Window  
         Resizing a Window  

Resizing a Window to Fit Its Image
To resize an Image Window so that it exactly fits its image, select "Fit to Image" from the 
Window Menu. 
Scrolling the Image Area
If an image is larger than its window can display, you can view it by scrolling through the 
image area. There are three ways to do this:

You access the Image Mover Tool by clicking on its button in the Select Toolbox.
When an image is larger than its window's image area, scrollbars will appear at the 

right side and/or bottom of the image area. 
You can use the cursor keys. 

Arranging All of the Image Windows
The Window Menu's Tile Command and the Cascade Command arrange all of the non-
minimized Image Windows. The Arrange Icons Command lines up all the of minimized 
Image Windows at the bottom of the Workspace. 
Closing Image Windows
When you close an Image Window, you are also closing the image's file. 

You can close a single Image Window... 
...Or you can close all of the Image Windows. 
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SEARCH: Image Window Control Box
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Zoom Tools
There are three command types that control the magnification of an image:

Zoom In: Magnifies an image. Makes it appear larger. 
Zoom Out: Reduces an image. Makes it appear smaller. 
Quick Normal View: Immediately returns the image to standard (1:1) magnification. 

Zoom In / Zoom Out
Hot Keys 

Press <Ctrl> + <+> to zoom in one level. 
Press <Ctrl> + <-> to zoom out one level. 

Menu Selections
There are two Zoom selections on the View Menu: Zoom In and Zoom Out. Each 
selection opens a sub-menu that lists all the relevant magnification factors. 
Zoom Control Panel

The Zoom Control Panel is the most common form of the Tool Control Panel. You set the 
magnification level using the Zoom Level Spin Control.

Quick Normal View 

To return an image to 1:1 magnification, click on the View Normal Button, or select "Normal
Viewing (1:1)" from the View Menu. 
Automatic Window Resizing
When the Fit Window to Image When Zooming Option in the General Preferences Dialog 
Box is turned on, Paint Shop Pro will automatically resize an Image Window when you zoom
in or out. 
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Pixel Grid
The Pixel Grid appears at magnification levels of 10:1 and greater. The grid is turned on 
when a check appears next to "Grid When Zoomed" on the View Menu. To turn the Pixel 
Grid on or off, you select "Grid When Zoomed": 

Click on "View" in the 
Menubar, then click on "Grid 
When Zoomed". 
Press <Alt> + <V>, then 
press <G>. 

Displaying an Image Full Screen
To display an image against a black, full-screen background, select "Full Screen" from the 
View Menu, or: 

Click on the View Full Screen 
Button. 
Press <Shift> + <F>. 

When an image is displayed full screen, it is frozen at the current zoom level. If the image 
is too big to fit on the screen, you can use the cursor keys to scroll through the image. To 
return to Paint Shop Pro's normal state, click anywhere, or press <Enter>. 
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Other Screen Components

There are five "parts" of Paint Shop Pro that you can choose to display or hide . You can 
turn display of a component on or off by selecting its name from the bottom half off the 
View Menu. In addition to the View Menu selections, the Toolbar has four buttons for 
controlling display of the Tool Windows (see section below). Clicking on these buttons turns 
display of the windows on and off. 

Tool Window Display Buttons

Paint Shop Pro will run faster with the Histogram Window closed, since it will not have to 
update the histogram whenever you change the image. 
Tool Windows
There are four Tool Windows: the Select Toolbox, the Paint Toolbox, the Tool Control Panel, 
and the Histogram Window. The Toolboxes contain the buttons for selecting tools, and the 
Tool Control Panel contains the controls for the active tool. The Tool Windows can be placed 
anywhere on the screen. 

         Positioning the Tool Windows  
         About Histograms  
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About Histograms
A histogram is a graph of an image's colors by luminance or brightness. The luminance 
spectrum appears on the horizontal axis, ranging from zero luminance (pure black) to full 
luminance (pure white). The vertical axis indicates the portion of the image's color that 
matches each point on the luminance spectrum. 

In the example at right, the image's luminance is clustered at the bottom of the midrange, 
and again near the top of the spectrum. The image is a photograph of hills and sky. The 
hills in the foreground are covered with grass and dark green pine trees, and the hills in the
background have a blue caste. These two elements create the bottom-midrange luminance
cluster. The sky and clouds create the second, high-range cluster. 
If our explanation of histograms has failed you, maybe this will help: converting an image 
to grey scale    replacing all of the image's colors with greys of corresponding shade    does 
not affect the histogram. A histogram is strictly a measure of brightness, and is not 
affected by any other color quality. 
Histogram Window
Paint Shop Pro displays a histogram for the active image in the Histogram Window. 

         Hiding/Displaying Screen Components   
Moving a Window

Histograms and Image Enhancement
A histogram can help you decide what changes might enhance an image's quality. Consider
the histogram on the left, which is from a photograph of rugged grey mountains covered 
lightly with snow, standing against a grey-blue sky. The photograph is a little harsh, and the
histogram shows why: the colors are bunched tightly near the top of the luminance 
spectrum. 

Before Adjustment After Adjustment

Changing the shape of the histogram will alter the image's balance of detail, and in some 
cases, that's exactly want you want do. In this case, the photograph's composition is quite 
good, so you want to retain the histogram's shape. By shifting the entire histogram down 
slightly, you can reduce the image's harshness and actually improve its overall balance. 
The change may seem minor, but the improvement to the human eye is significant. 
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Color Definition Methods
There are several methods for defining the projected colors that appear on a computer 
monitor. The two most common methods, which are also the methods used by Paint Shop 
Pro's functions and dialog boxes, are red, green, and blue and hue, saturation, and 
luminance (see below). The following tableTable A-2.1 outlines the Color Dialog Box RGB 
and HSL settings for the standard white light color spectrum. 

Color Dialog Box Settings: While Light Color Spectrum

Red, Green, and Blue (RGB)
The most popular method for defining a projected color is as a combination of red, green, 
and blue. For example, pure red is defined by red = 100%, green = 0%, and blue = 0%. 
Pure black has red, green, and blue values of 0%, and pure white has red, green, and blue 
values of 100%. 
Hue, Saturation, and Luminance (HSL)
A projected color can be defined by the three characteristics of hue, saturation, and 
luminance: 

Hue describes the color's shade or tint. It is measured on a circular spectrum running 
from red to green to blue and returning to red. 
Saturation describes the hue's purity. A color with a saturation of 100% is bright and 
vivid, and a color with a saturation of 0% is a shade of grey. 
Luminance describes the color's brightness. A color with luminance of 100% is always 
pure white, and a color with luminance of 0% is always pure black. 
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Gamma Correction
An image is stored in computer memory as a series of numbers. Depending on the image's 
format, a pixel's values can be described a variety of ways: 

By the binary number range of 0 to 1.
By three separate numbers, each on a scale of 0 to 255.
By some other system, usually falling between these two in complexity. 

All of these formats have at least one thing in common: a higher number means a brighter 
color value. This rule has two corollaries: (1) the highest combination of values possible for 
a pixel produces pure white; and (2) the lowest combination of values possible for a pixel 
produces pure black. 
It would follow logically that a value half-way up any scale would have a luminance exactly 
between black and white. This assumes that our hypothetical scale would allow an integer 
value exactly in the middle, which in reality it would not: image formats are based on 
powers of two, so integer midpoints are not possible. 
To get over this hurdle, let's consider an approximate midpoint, and to base it in reality, 
let's assume that the image is in a 256 color grey scale format. A graph of a monitor's pixel
output over the image's potential pixel values would look like the following figure. Our 
approximate midpoint    say 120    would produce an identical luminance on the monitor. 

Linear Luminance (Example)

A computer monitor displays colors by exciting phosphors on the screen. Unfortunately, 
phosphors do not excite linearly. For example, if a computer reads a luminance value from 
a photographic image and sends it directly to the monitor, the displayed color will be 
dimmer than in the original photograph. 
As you may have already guessed, this is where gamma correction comes in: a gamma 
correction value adjusts for the nonlinearity of phosphor excitation. The following diagram 
provides an example of how gamma correction can alter the color values sent to a 
computer monitor. In this case, our approximate midpoint of 120 produces a monitor value 
of 168. 

Gamma-Corrected Luminance (Example)



Determining Your Monitor's Gamma Level 
Included with Paint Shop Pro is a file named GAMMA.TIF. You can use GAMMA.TIF to determine
your monitor's gamma level. Follow these steps: 

Open GAMMA.TIF
GAMMA.TIF will be in Paint Shop Pro's root directory. If you used the default installation, 
it will be in C:\PSP. 
Duplicate the GAMMA.TIF 
Window
You do not want to accidentally save a gamma-corrected version of GAMMA.TIF. If you 
do, you will no longer be able to use the file to test gamma levels. To copy the file, 
select "Duplicate" from the Window Menu. To avoid any accidents, close GAMMA.TIF. 
Find the Gamma Correction 
Value
The GAMMA.TIF image is made up of four sections, one each of red, green, blue and 
grey. Each section has an outer area and a center area. The outer area is a dithered 
pattern of pixels with luminance values of 0 and 255, and the center area contains 
pixels with a luminance value of 128. 
Use the Gamma Correct Function to adjust the image's gamma level so that these two
areas are of equal brightness. The correction value that synchronizes their luminance 
is the gamma level of your monitor. 
A good starting value is 2.0. The Preview Box for the Gamma Correct Function is not 
very reliable for this particular task. If the results aren't right, use the Undo Command 
to remove the effects of the Gamma Correct Function, then try again. 
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Error Diffusion Dithering
Dithering is a technique for simulating colors that are missing from an image file's palette. 
Missing colors are is simulated by intermingling pixels of two or more palette colors. If the 
unavailable color differs too greatly from the colors in the image's palette, dithering will 
produce a grainy or mottled appearance. 
Error diffusion dithering is a popular dithering method. The "error" in the title refers to the 
cumulative difference between the actual values of pixels in the image and their "true" 
values if they were all set to their correct colors. By reducing this error, error diffusion 
dithering produces image quality that is superior to that achieved by non-error adjusted 
dithering. 
The process starts at the first pixel in the image (the upper left corner). The algorithm finds
the color in the palette that is nearest to the color of the pixel. It then compares the two 
colors' numerical values, saves the difference as the initial error, and applies the color from
the palette to the pixel. 
The process then proceeds to the second pixel. It finds this pixel's nearest color, and 
calculates the sum of the color and the error value from the last pixel. It sets the pixel to 
the color that is nearest to this sum. Any difference between the applied color and the sum 
becomes the new error value. 
When the process reaches the third pixel, it repeats the procedure that was used to set the 
color for the second pixel. The algorithm cycles through the image's remaining pixels in the
same manner. The error value is abandoned at the end of each row, and is created anew at
the beginning of each row. 
Reduce Color Bleeding Option
As you may have suspected, error diffusion dithering causes colors to bleed from left to 
right. This is because the algorithm, and therefore the error value, travels in this direction. 
Color bleed is most noticeable in images with hard vertical edges, because the edges are 
softened by the traveling color. 
Paint Shop Pro functions that use error diffusion dithering include a Reduce Color Bleeding 
Option. This option lessens the left-to-right color bleed by applying a fractional coefficient 
to the error value. By reducing the error value, less color information is carried from one 
pixel to the next. Because it reduces error correction, the Reduce Color Bleeding Option 
hurts the quality of some images, but it can improve the quality of images with hard 
vertical edges



 



File Formats
TOPIC: File Formats



File Formats

Overview
Direct File Format Support
Paint Shop Pro directly supports 35 different file formats: 

         26 raster image formats   
         9 meta and vector image formats   
Support for External Import filters
Paint Shop Pro can read other file formats if the appropriate external import filters are 
installed on your system. 
Palette File Format
Paint Shop Pro uses a text file format for storing palette information. 
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Raster Image Formats
A raster format breaks an image into a grid of equally-sized pieces, called "pixels", and 
records color information for each pixel. The number of colors that the file can contain is 
determined by the bits-per-pixel: the more information that is recorded for each pixel, the 
more shades and hues that the file can contain. 
Bits-Per-Pixel and Color Depth
Most raster formats support more than one level of bits-per-pixel, and therefore more than 
one level of color. The following table lists the bits-per-pixel ratios in the raster formats that
Paint Shop Pro supports, and shows the corresponding maximum number of colors. 

Bits-Per-
Pixel

Maximum Number of Colors 

1 2
4 16 
8 256 
16 32,768 or 65,536 (depends on

format)
24 16,777,216 
32 16,777,216 

Most raster formats record color information on pixel-by-pixel basis, but some formats use 
color planes. Each color plane contains all of the pixel information for a single color. Color 
planes are also called "color channels". Formats that use color planes are called "planar" 
formats. 
The bits-per-pixel are determined by the bits-per-plane times the number of planes. If the 
resulting number is not a power of two (expressible as 2x, where x is an integer), then the 
bits-per-pixel are "promoted" to the next- highest power of two. For example, if there are 
two bits-per-plane and three planes, the bits-per-pixel are promoted to eight: 2 x 3 = 6, and 
22 < 6 < 23. 
Supported Formats
The following table lists the raster file formats supported by Paint Shop Pro.

 = Paint Shop Pro can open files of this specification  = Paint Shop Pro can save files to this 
specification
Form
at

Sub-Format / 
Description

Source/Standard Bits-Per-Pixel and Color Type

  1 4 8
Grey

8
Color

16 24 32

BMP RGB encoded OS/2
BMP RGB encoded Microsoft Windows 
BMP RLE encoded Microsoft Windows 
CLP Bitmap Windows Clipboard
CLP Device Independent Bitmap Windows Clipboard
CUT Dr. Halo 
DIB RGB encoded OS/2
DIB RGB encoded Microsoft Windows 
DIB RLE encoded Microsoft Windows 
GIF Ver. 87a (interlaced) CompuServe 
GIF Ver. 87a (non-interlaced) CompuServe 
GIF Ver. 89a (interlaced) CompuServe 
GIF Ver. 89a (non-interlaced) CompuServe 



IFF Compressed Electronic Arts 
IFF Uncompressed Electronic Arts 
IMG Old Style GEM Paint 
IMG New Style GEM Paint 
JAS JASC format; obsolete JASC, Inc.
JIF Huffman compressed Joint Photo. Expert 

Group
JPG Huffman compressed Joint Photo. Expert 

Group
LBM Compressed Deluxe Paint
LBM Uncompressed Deluxe Paint
MAC With header MacPaint
MAC Without header MacPaint
MSP New version Microsoft Paint 
MSP Old version Microsoft Paint 
PBM Portable Bitmap UNIX 
PCD Kodak Photo CD 
PCX Version 0 ZSoft Paintbrush 
PCX Ver. 2 (with palette info.) ZSoft Paintbrush 
PCX Ver. 3 (without palette info.) ZSoft Paintbrush 
PCX Version 5 ZSoft Paintbrush 
PGM Portable Graymap UNIX 
PIC Pictor/PC Paint
PPM Portable Pixelmap UNIX 
PSD RGB or indexed Photoshop
RAS Type 1 (Modern Style) Sun Microsystems 
RAW Un-encoded pixel data
RLE CompuServe CompuServe
RLE Windows Microsoft Windows
TGA No compression Truevision 
TGA Compressed Truevision 
TIFF Huffman compressed Aldus Corporation
TIFF No compression Aldus Corporation
TIFF Pack bits compressed Aldus Corporation
TIFF LZW compressed Aldus Corporation
TIFF Fax Group 3 compressed Aldus Corporation
TIFF Fax Group 4 compressed Aldus Corporation
WPG Version 5.0 WordPerfect
WPG Version 5.1 WordPerfect
WPG Version 6.0 WordPerfect
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Meta and Vector Image Formats
Meta and vector image formats can both contain vector information. Vector information is a
collection of geometric shapes that combine to make an image. The information is 
recorded as mathematical formulas. Vector data cannot reproduce photo-realistic images, 
but for other types of images it has two advantages over raster data: it is scaleable without
distortion (the "jaggies" that come with re-sizing a bitmap), and it produces smaller files. 
In the strictest definition, a vector format can only contain vector information. In common 
practice, many formats that are considered to be vector allow the user to include non-
vector data, such as raster images or text. 
Meta formats explicitly allow more than just vector data. For example, a typical Windows 
metafile might contain a bitmap, vector information, and text, with the bitmap constituting 
the majority of the image, and the vector and text data providing annotation. 

Paint Shop Pro can read vector data, but it cannot write vector data. When you view a 
vector image from Paint Shop Pro, what you are seeing is a raster image based on the 
vector data. Paint Shop Pro imports the vector image and converts it to an internal raster 
format. Paint Shop Pro can write to the Windows metafile format, but the resulting files 
contain raster data only. 
Supported Formats
The following table lists the meta and vector formats supported by Paint Shop Pro.

 = Paint Shop Pro can open files of this format
 = Paint Shop Pro can save files to this format

Format Source/Standard Open/Save
CDR CorelDRAW!
CGM Computer Graphics Metafile
DRW Micrografx Draw
DXF Autodesk
GEM Ventura/GEM
HGL Hewlett-Packard Graphics Language
PIC Lotus Development Corp.

WMF Microsoft Windows Metafile *
WPG WordPerfect (versions 5.0 and 5.1)

*When you save data in the Windows metafile format, the file 
contains raster data only. JASC has provided this capability at the 
request of its customers.
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Other Formats: External Import Filters
In addition to the file formats that it supports directly (see Raster Image Formats and Meta 
and Vector Image Formats), Paint Shop Pro can also read other image file formats if the 
appropriate external import filters are installed on your system. Most major software 
applications, such as Microsoft Word®, install external import filters. A common file type 
that Paint Shop Pro can support via external import filters is the Macintosh® PICT format 
(".PCT"). 
In Paint Shop Pro's dialog boxes, the file types that are supported via external import filters 
have "EXT:" after the file extension. For example, the Macintosh® PICT format appears as 
"PCT - EXT: Macintosh PICT (.PCT)". 
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Jasc Palette File Format

The Jasc palette file format is not the same as the Microsoft PAL format. 
Paint Shop Pro uses the Jasc palette file format (extension ".PAL") for saving 16 and 256 
color palette files. The file type was created as a text file so that you can edit or create 
palettes with a text editor, such as Notepad. The file structure is as follows:

Header: JASC-PAL
Version: 0100
Number of Colors: 16 or 256
Palette Data: Made up of Red, Green and Blue color components. Color components

are values from 0 to 255. RGB values must be separated by one 
space. Each RGB series must be on a separate line. 

Example
The following is Window's default colors in the Jasc PAL file format: 

JASC-
PAL
0100
16
0 0 0
0 0 
191
0 191 
0
0 191 
191
191 0 
0
191 0 
191
191 
191 0
192 
192 
192
128 
128 
128
0 0 
255
0 255 
0
0 255 
255
255 0 
0
255 0 
255
255 
255 0
255 
255 
255
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Troubleshooting Overview
This section contains answers to the most common technical support questions. Refer to 
the README.TXT file in your Paint Shop Pro directory to see if there are any additional 
questions and answers that were not available when this help file was published.
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Color Problems

Changing Your Video Driver
If your video card supports higher color resolutions, installing a video driver that supports 
more colors should improve your image display quality. To determine your current display 
resolution, click on "Help" in the Menubar, then click on "About Paint Shop Pro". Look at the
line marked "Resolution" in the About Paint Shop Pro Dialog Box. The last number is the 
number of colors that your display supports. For help changing your video driver, consult 
the documentation that came with your video card. 

Colors in an image are wrong
Your video card and/or video driver probably don't support enough colors to show the 
image correctly. For help changing your video driver, see above.

16 Color Display Drivers
When displaying sixteen colors, Windows uses a set palette that cannot be changed. 
Images are mapped to the closest colors in the Windows palette: a color that is not in 
the palette is replaced by the nearest color that is. The more colors the image contains,
the more colors that are lost when the image is mapped. 
256 Color Display Drivers
When it's running a 256 color display driver, Windows reserve 20 colors for its own use. 
This alters an image's available palette to 236 independent or optimized colors (256 - 
20 = 236), plus the 20 fixed Windows colors. Images are mapped to the closest colors 
in the available palette: a color that is not in the palette is replaced by the nearest color
that is. 

Image is grainy or mottled
Your video card and/or video driver probably don't support enough colors to show the 
image correctly. For help changing your video driver, see above.
The graininess is caused by dithering. Paint Shop Pro automatically dithers images that 
contain more colors than the video system can display. Dithering provides the best possible
color approximation. 
Paint Shop Pro maintains the original, un-dithered image in memory. If you edit the image, 
the change is applied to the original and a new dithered image is created to display your 
changes. This allows you to work with images that are beyond the limits of your video 
system.
Wallpaper colors change as different images are displayed
When it's running a 256 color display driver, Windows reserve 20 colors for its own use. 
This leaves 236 colors that can be optimized to display an image (256 - 20 = 236). 
When Paint Shop Pro displays an image, Windows gives it control of the 236 available 
colors, which Paint Shop Pro optimizes to best suit the active image. In so doing, Paint Shop
Pro alters the common palette that is being used by the wallpaper, and for that matter, the 
entire screen. 
Once Paint Shop Pro or the offending image is closed, the wallpaper's colors should return 
to normal. 
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File Format Problems

Paint Shop Pro won't load a WPG image.
The file is probably a WPG Version 6 vector image. Paint Shop Pro did not support the 
Version 6 vector sub-format at the time this help file was written. 

         Supported File Formats  
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Memory Problems

Editing image causes memory error message.
Depending on its size and resolution, an image may require substantial amounts of 
memory to be displayed, and even more memory to be edited. The following example 
shows how the memory requirements of an image escalate as its color depth increases.

Editing an image may require up to three times the amount of memory required to display 
the image. Turning the Undo buffer off may decrease the memory requirements. 
When Windows 3.1 is running in Enhanced Mode, it can use a swap file to simulate 
additional memory. A swap file allows systems with large amounts of memory to operate 
Paint Shop Pro very quickly, and lets systems with less memory run Paint Shop Pro with less
risk of encountering memory errors. For help setting up a swap file, see your Windows 
documentation, or contact your hardware support provider or personnel. 
Paint Shop Pro says an image is about twice as big as it should be. 
The difference in size is caused by an Undo buffer. An image will have an Undo buffer if the 
Undo Storage Option is set to "In Memory". 

         Undo Storage Options  



TOPIC: Operations



Troubleshooting

Operation Problems

Why are some functions unavailable for 16-color and 256-color formats?
These functions create new pixel values that may not have existed in the original image. 
Only 24-bits-per-pixel images and 8-bits-per-pixel grey scale images have the required 
internal structure to hold any and all of these new pixel values.
Printing crashes Windows, Print Manager, or Paint Shop Pro. 
You will be unable to print an image if your Windows temporary directory does not have 
enough room to hold the image file. Something will crash: it could be Windows, it could be 
Print Manager, or it could be Paint Shop Pro. 
We at JASC firmly believe that it is a bad idea to use a RAM drive as your Windows 
temporary directory. The allocated memory goes to waste, and it constrains the size of 
your temporary directory. 
For more help, contact your hardware support provider or personnel. 
 



POPS: Main Window 



Main Window Titlebar 
The Main Window Titlebar displays "Paint Shop Pro" and contains the 
standard Windows titlebar controls. 



Menubar 
The Menubar contains Paint Shop Pro's menus. Each menu lists
a "family" of selections, and each selection performs a specific 
action. 



Toolbar
Toolbar buttons perform an action, just like a menu selection. You select a 
Toolbar button by clicking on it. 



Workspace 
The Workspace is where you edit images: 
when you open a file or create a new image, 
Paint Shop Pro opens a new image window 
within the Workspace. 



Workspace 
The Workspace is where you edit images: 
when you open a file or create a new image, 
Paint Shop Pro opens a new image window 
within the Workspace. 



Statusbar 
The Statusbar displays information about the current image and/or the 
current task. 



Control Box
At the left end of each titlebar is the Control Box, 
which you use to access the window's Control 
Menu. Double-clicking on the Control Box closes 
the window.
Control Menu
To open the Control Menu, click on the Control 
Box. You can use the Control Menu to position the
window from the keyboard, to close the window, 
or to access your system's task manager. To 
choose a menu selection, you can click on it, 
press its underlined letter, or use the cursor keys 
to highlight it and then press <Enter>. 

POPS: Toolboxes 



Tool Control Panel: Examples 



POPS: Opening Files 



Most-Recently Used List (Example)



POPS: File Selection Features 



Drive Drop Down Box (Example)
Click on the drop down box to 
open it, then click on the drive 
that you want. If the list is too 
long to fit in the box, use the 
scroll bar to move through it.
Press <Alt> + <V> to access 
the drop down box, then press 
the drive letter.



Directories List Box (Example)
Double-click on the 
directory or its folder 
icon. Use the scroll bars 
to move up and down the
directory tree.
Press <Alt> + <D> to 
access the list box, use 
the cursor keys to 
highlight the directory, 
then press <Enter>. 

If you are unfamiliar with directories and 
directory trees, see your Windows 
documentation. 



File Type Drop Down Box (Example)
Click on the drop down box to 
open it, then click on the file type 
that you want. If the list is too long
to fit in the box, use the scroll bar 
to move through it.
Press <Alt> + <T> to access the 
drop down box. You use the cursor 
keys and letter keys to highlight a 
selection. Pressing a letter key 
once moves to the first format that
begins with that letter. Pressing it 
again moves to the second.



File Sub-Format Drop Down Box 
Click on the drop down box to open 
it, then click on the sub-format that 
you want. If the list is too long to fit 
in the box, use the scroll bar to move
through it.
Press <Alt> + <S> to access the 
drop down box. You use the cursor 
keys and letter keys to highlight a 
selection. Pressing a letter key once 
moves to the first sub-format that 
begins with that letter. Pressing it 
again moves to the second.



File Name Text Box

To access the File Name Text Box:
Double-click in it to overwrite 
the current text, or click in it 
once to edit the text.
Press <Alt> + <N>.



File Name List Box (Example)
Click on the file's entry in the list box. 
If the list is too long to fit in the box, 
use the scroll bar to move through it.
Press <Alt> + <N> and then <Tab> 
to access the list box, then use the 
cursor keys and letter keys to 
highlight the filename. Pressing a 
letter key once moves to the first file 
that begins with that letter. Pressing it 
again moves to the second.



POPS: Miscellaneous 



Preview Box
The Preview Box will display a selection, if the 
image contains one, even if the function will 
affect the entire image. If the image does not 
contain a selection, then the Preview Box will 
display the entire image. 



Positioning Buttons



Copyright  1990-1995 JASC, Inc.

Developed by:
Windows  Documentation 
Specialists
Want your help file to look this good? 
Contact us via CompuServe at 74551,3060



Sixteen Color Display Prompt
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Color Adjustment Function Dialog Box 
(Example)



Brightness / Contrast Function
 
Scale = -100% to +100%

Setting Effect
Brightness Shifts entire histogram in the direction of 

change. Positive 100% turns image or selection
pure white. Negative 100% turns image or 
selection pure black. 

Contrast Positive change flattens histogram, producing 
wider range of luminance. Negative change 
tightens histogram, producing narrower range 
of luminance. 



Gamma Correct Function
 
Scale = 0.01 to 4.99

Setting Effect
Correction Gamma correction 

factor. 



Highlight / MidTone / Shadow Function
 
Scale = 0% to +100%

Setting Effect
Highlight Adds luminance proportionally. Lighter pixels 

are increased more, darker pixels are increased
less. 

MidTone Shifts mid-quarter of luminance scale up or 
down.

Shadow Removes luminance proportionally. Darker 
pixels are reduced more, lighted pixels are 
reduced less. 



Hue / Saturation / Luminance Function
 
Scale = -100% to +100%

Setting Effect
Hue Increases/decreases hue. Moves all colors up or

down red/green/blue spectrum. 
Saturation Increases/decreases saturation. -100% 

converts image or selection to grey scale. 
Luminance Increases/decreases luminance. -100% 

produces pure black. +100% produces pure 
white if original histogram is in top half of 
luminance spectrum. 



Red / Green / Blue Function
 
Scale = -100% to +100%

Setting Effect
Red Increases/decreases red level 
Green Increases/decreases green level 
Blue Increases/decreases blue level 



Colorize Dialog Box (Example)



Colorize Function Settings
 
Scale = 0 to 255

Setting Effect
Hue Sets hue for image or selection.

Spectrum is red/green/blue.
Saturation Sets saturation for image or 

selection. 0 produces grey 
scale. 



Posterize Dialog Box (Example)



Solarize Dialog Box (Example)
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Color Palettes
You can edit, load, and save color palettes for 
16 and 256 color images. You can load color 
palettes into images with color depths of 16 
or more. 



Color Palette Dialog Box (Example)



Load Palette Dialog Box



Save Palette Dialog Box



Color Dialog Box



Decrease Color Depth Dialog Box: 2 Colors Version



Decrease Color Depth Dialog Box: 16 Colors Version



Decrease Color Depth Dialog Box: 256 Colors Version



Decrease Color Depth Dialog Box: 32K Colors 
Version



Decrease Color Depth Dialog Box: X Colors Version
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New Image Dialog Box



Capture Types
Type Action
Area Use the mouse to select a rectangular portion of the 

screen.
Full Screen Copy the entire screen.
Client Area Copy the input section of the active window.
Window Copy the entire active window.
Object Copy a window feature or group of features. 



Capture Setup Dialog Box



Acquire Image Button
Clicking on the Acquire Image 
Button accesses the TWAIN 
device software's Acquire 
Dialog Box.
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Add Borders Dialog Box



Enlarge Canvas Dialog Box



Resize Dialog Box



Resample/Resize Text Boxes



Rotate Dialog Box



Image Information Dialog Box
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Effects Browser Dialog Box (Example)



Apply User Defined Filter Dialog Box



Filter Matrix (Example)



Simple Filter Calculation Example: 



Define New Filter Dialog Box
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Batch Processing Status Dialog Box
The Batch Processing Status Dialog Box displays mesages 
about the batch conversions progress. To stop the batch 
conversion, select the Abort Button. 

When the conversion is complete, the Abort Button will be 
replaced by a Close Button and a Save Log Button. 
Selecting the Close Button shuts the dialog box. Selecting 
the Save Log Button opens the Save Dialog Box, which you 
can use to save the progress messages to a text file. 



Print Dialog Box



Print Quality Drop Down Box
The entries in the Print Quality Drop 
Down Box are determined by the type of
printer you are using. 

Click on the drop down box to open 
it, then click on a selection.
To access the drop down box, press 
<Alt> + <Q>. Use the cursor keys 
to highlight the selection you want.



Copies Text Box

Enter the number of copies that you want to 
print into the Copies Text Box. If your printer 
does not support multiple copies, the text 
box will be grayed out. To access the text 
box, click in it, or press <Alt> + <C>. 



Save File Prompt (Example)

Click on the Yes Button to save the file and close it.
Click on the No Button to close the file without saving it.
Click on the Cancel Button to leave the file open. 



 Delete File Prompt (Example)

To delete the file, click on the Yes Button, or press <Enter>.
To leave the file intact, click on the No Button, or press 

<Alt> + <N>. 
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Open Image Dialog Box



File Info Dialog Box
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Meta Picture Import Dialog Box 
(Example)



PCD Size Dialog Box 



RAW Options Dialog Box 



File Save As Dialog Box



Filename In Use Prompt



Select Window Dialog Box 

Double-click on the image's 
filename, or click on it once, 
then click on the OK Button. 
Use the scrollbar to move 
through the list. 
Use the cursor keys and letter 
keys to highlight a filename. 
Pressing a letter key once 
moves to the first file that 
begins with that letter. Pressing 
it again moves to the second. 



Select Area Dialog Box



Select Directory Dialog Box



New Windows Dialog Box



Maximized
A window is maximized when it occupies all of its 
available space.



Minimized
A window is minimized when it is reduced to 
an icon.



Restore
Restoring a window returns it to its 
last non-minimized, non-maximized
position.
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Add Mask Channel Dialog Box



Mirror Luminance
A color's "mirror" luminance is equal to the
luminance of white minus the color's 
current luminance. For example, since 
white has a luminance value of 255, a 
color with a luminance of 100 would have 
a mirror luminance of 155.
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Page Setup Dialog Box (Example)



Print Setup Dialog Box (Example)



Control Panel's Printers 
Option
You use the Control Panel's 
Printers Option to change the 
default printer. 

Control Panel IconPrinters Option 
Icon



Portrait vs. Landscape
Portrait is taller than it is 
wide, landscape is wider 
than it is tall. 



General Preferences Dialog Box



General Preferences Tabs
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Standard Brush
You access the Standard 
Brush by clicking on its 
button in the Paint Toolbox. 
The image cursor will change
to a paintbrush.

Button Cursor



Standard Brush Control Panel
To access Standard Brush Control Panel, 
double-click on the Standard Brush Button. 



Clone Brush
You access the Clone Brush 
by clicking on its button in 
the Paint Toolbox. The image
cursor will change to a 
paintbrush.

Button Cursor



Clone Brush Control Panel
To access Clone Brush Control 
Panel, double-click on the Clone 
Brush Button. 



User-Defined Brush
You access the User-Defined 
Brush by clicking on its button 
in the Paint Toolbox. The image 
cursor will change to a 
paintbrush.

Button Cursor



User Brush Control Panel

First Set of Controls

Second Set of Controls



Push Brush
You access the Push Brush 
by clicking on its button in 
the Paint Toolbox. The image
cursor will change to a 
paintbrush.

Button Cursor



Push Brush Control Panel
To access Push Brush Control Panel,
double-click on the Push Brush 
Button. 



Airbrush
You access the Airbrush by 
clicking on its button in the 
Paint Toolbox. The image 
cursor will change to a 
paintbrush.

Button Cursor



Airbrush Control Panel
To access Airbrush Control 
Panel, double-click on the 
Airbrush Button. 



Fill Tool
You access the Fill Tool by 
clicking on its button in the 
Paint Toolbox. The image 
cursor will change to a 
tipping pitcher.

Button Cursor



Fill Tool Control Panel
To access Fill Tool Control Panel, 
double-click on the Fill Tool 
Button. 



Pen
You access the Pen by 
clicking on its button in the 
Paint Toolbox. The image 
cursor will change to a pen.

Button Cursor



Pen Control Panel
To access Pen Control Panel, 
double-click on the Pen Button. 



Pencil
You access the Pencil by 
clicking on its button in the 
Paint Toolbox. The image 
cursor will change to a 
pencil.

Button Cursor



Pencil Control Panel
To access Pencil Control Panel, 
double-click on the Pencil Button. 



Marker
You access the Marker by 
clicking on its button in the 
Paint Toolbox. The image 
cursor will change to a 
marker.

Button Cursor



Marker Control Panel
To access Marker Control Panel, 
double-click on the Marker Button.



Crayon
You access the Crayon by 
clicking on its button in the 
Paint Toolbox. The image 
cursor will change to crayon.

Button Cursor



Crayon Control Panel
To access Crayon Control Panel, 
double-click on the Crayon 
Button. 



Chalk
You access the Chalk by 
clicking on its button in the 
Paint Toolbox. The image 
cursor will change to a piece
of chalk.

Button Cursor



Chalk Control Panel
To access Chalk Control Panel, 
double-click on the Chalk Button. 



Charcoal
You access the Charcoal by 
clicking on its button in the 
Paint Toolbox. The image 
cursor will change to a piece
of charcoal.

Button Cursor



Charcoal Control Panel
To access Charcoal Control Panel, 
double-click on the Charcoal 
Button. 



Swap Brush
You access the Swap Brush 
by clicking on its button in 
the Paint Toolbox. The image
cursor will change to an 
eraser.

Button Cursor



Swap Brush Control Panel
To access Swap Brush Control 
Panel, double-click on the Swap 
Brush Button. 



Undo Brush
You access the Undo Brush 
by clicking on its button in 
the Paint Toolbox. The image
cursor will change to an 
eraser.

Button Cursor



Undo Brush Control Panel
To access Undo Brush Control Panel,
double-click on the Undo Brush 
Button. 



Text Tool
You access the Text Tool by 
clicking on its button in the Paint
Toolbox. The image cursor will 
change to crosshairs with a 
trailing "T".

Button Cursor



Add Text Dialog Box



Font Combo Boxes

 
Click on its entry in the list section of the appropriate combo
box. Use the scroll bar to move through the list.
Press <Alt> plus the combo box's underlined letter (<F>, 
<Y>, or <S>) to access the text section of the combo box, 
then type your selection. If the entry is available, Paint Shop
Pro will highlight it in the list. You can use the cursor keys to 
move through the list. 



Text Effects Check Boxes

To turn a text effect on or off: 
Click on the effect's title or 
its check box. 
Press <Alt> plus the 
underlined letter in the 
effect's title.



AntiAlias Effect
Bitmapped text is created by assembling square 
pixels, which can create jagged characters, 
especially at larger font sizes. The AntiAlias effect 
corrects for "the jaggies" by using shades of the 
text's color to soften the characters' edges. 

AntiAlias Effect: With & Without

Anti-aliasing is only available for 256 color grey 
scale and for color depths greater than 256. 

Increasing an Image's Color Depth



Shadow Effect
The Shadow Effect creates the impression 
that the letters are slightly above the page 
and are illuminated from above and to the 
left. The shadow appears in the current 
background color. 

Shadow Effect



Rotate 90 Degrees Effect
The Rotate 90 Degrees effect 
spins the text 90° counter-
clockwise from the regular 
horizontal position. 

Rotated Text



Special Effects Check Boxes

To turn a text effect on or off: 
Click on the effect's title or 
its check box. 
Press <Alt> plus the 
underlined letter in the 
effect's title.



Line Tool
You access the Line Tool 
by clicking on its button 
in the Paint Toolbox. The 
image cursor will change 
to line.

Button Cursor



Line Tool Control Panel
To access Line Tool Control Panel, 
double-click on the Line Tool 
Button. 



Hollow Rectangle Tool 
You access the Hollow 
Rectangle Tool by clicking on 
its button in the Paint Toolbox. 
The image cursor will change 
to an empty box.

Button Cursor



Hollow Rectangle Tool Control Panel
To access Hollow Rectangle Tool Control 
Panel, double-click on the Hollow Rectangle 
Tool Button. 



Solid Rectangle Tool
You access the Solid 
Rectangle Tool by clicking on 
its button in the Paint Toolbox.
The image cursor will change 
to solid square.

Button Cursor



Hollow Oval Tool
You access the Hollow Oval Tool by 
clicking on its button in the Paint 
Toolbox. The image cursor will 
change to an empty circle with 
trailing crosshairs.

Button Cursor



Hollow Oval Tool Control Panel
To access Hollow Oval Tool Control 
Panel, double-click on the Hollow Oval 
Tool Button. 



Solid Oval Tool
You access the Solid Oval Tool by 
clicking on its button in the Paint 
Toolbox. The image cursor will 
change to solid circle with trailing 
crosshairs.

Button Cursor



Smooth Brush
You access the Smooth 
Brush by clicking on its 
button in the Paint Toolbox.
The image cursor will 
change to teardrop.

Button Cursor



Smooth Brush Control Panel
To access Smooth Brush Control 
Panel, double-click on the Smooth 
Brush Button. 



Sharpen Brush
You access the Sharpen 
Brush by clicking on its 
button in the Paint Toolbox. 
The image cursor will 
change to triangle.

Button Cursor



Sharpen Brush Control Panel
To access Sharpen Brush Control 
Panel, double-click on the Sharpen 
Brush Button. 
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Color Selector Tool
You access the Color Selector 
Tool by clicking on its button in
the Select Toolbox. The image 
cursor will change to an 
eyedropper.

Button Cursor



Magnifier Tool
You access the Magnifier Tool 
by clicking on its button in 
the Select Toolbox. The image
cursor will change to a 
magnifying glass.

Button Cursor



Image Mover Tool
You access the Image 
Mover Tool by clicking on 
its button in the Select 
Toolbox. The image cursor 
will change to a hand.

Button Cursor



Rectangle Selector Tool
You access the Rectangle Selector 
Tool by clicking on its button in the 
Select Toolbox. The image cursor 
will change to crossharis with a 
trailing square.

Button Cursor



Oval Selector Tool
You access the Oval Selector Tool 
by clicking on its button in the 
Select Toolbox. The image cursor 
will change to crosshairs with a 
trailing circle.

Button Cursor



Oval Selection's "Corners"



Selection Adjuster Tool
You access the Selection 
Adjuster Tool by clicking on its 
button in the Select Toolbox. 
The image cursor will change 
to a four-headed arrow. 

Button Cursor



Cloner Tool
You access the Cloner Tool by 
clicking on its button in the 
Select Toolbox. The image 
cursor will change to a four-
headed arrow.

Button Cursor



Lasso Tool
You access the Lasso Tool by 
clicking on its button in the Select
Toolbox. The image cursor will 
change to crosshairs with a 
trailing lasso.

Button Cursor



Crossed Boundary
(Example)



Magic Wand Dialog Box



Magic Wand Tool
You access the Magic Wand Tool 
by clicking on its button in the 
Select Toolbox. The image cursor 
will change to crosshairs with a 
trailing wand.

Button Cursor



Color Tools
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MDI Child Windows
In Windows programming parlance, Image 
Windows are known as MDI Child Windows, 
or as document windows. MDI stands for 
Multiple Document Interface, which means 
that the application can open more than 
one file at a time. 
Child windows are subordinate to and 
controlled by another window. A window 
that has "children" is called a parent 
window. Paint Shop Pro's Main Window is an
example of a parent window. 



Titlebar Text Display
The titlebar text display shows the 
image file's name and its current 
magnification. If a mask is attached
to the image, an M will appear after
the magnification level. 

Zooming In and Out
Masks



Resizable Border
You can use the mouse to resize an 
Image Window by grabbing and dragging
its border.

Resizing a Window



Image Area
The image area is where you do 
your work. It's an Image Window's
equivalent of the Main Window's 
Workspace.

Basic Image Editing
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Active Colors
There are two active colors, the foreground color 
and the background color. You can select the 
active colors using the Color Tools, which are 
grouped at the bottom of the Select Toolbox, or 
you can use the Color Selector to select the 
active colors directly from an image.
When you're using the Paint Tools, the foreground
color is activated by the primary mouse button, 
and the background color is activated by the 
secondary mouse button. The background color is
also the fill color for new images. 

Color Selector
Color Tools



Color Depth
The number of colors that an image file's 
format can record. Typically 2, 16, 256, or 
16.7 million. Images that can contain 16.7 
million colors are commonly referred to as 
"16 million color images". 



Primary Mouse Button
On a two-button mouse, the primary 
button is the one that you use more 
often. For most users, it's the left 
button. If you're left-handed, your 
buttons may be reversed, in which case 
the primary button would be on the 
right.



Secondary Mouse Button
On a two-button mouse, the secondary 
button is the one that you use less often. 
For most users, it's the right button. If 
you're left-handed, your buttons may be 
reversed, in which case the secondary 
button would be on the left.
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Histogram Window 
(Example)



 



SECTION: Order Forms



Purchasing Jasc Products
You can purchase Jasc products from the vendor of your choice. To see a vendor's order form,
click on their name:

Vendor Location
Budgetware Australia
Pro Soft Denmark
Digital Workshop England
WindowShare France
Verlag Gisela Lakies Germany
BroCo Software Nederlan

d
Personal Data 
Factory

Japan

Jasc, Inc. USA

If you live in Europe and purchase a Jasc product from a distributor outside of Europe, you 
will be liable for the VAT and Customs charges. Because of this, buying at a lower price from 
a non-European distributor may actually cost you more. 
Special Offers!

If you purchase Paint Shop Pro, you can purchase Jasc Media Center at a reduced 
price. 

You will receive 100 WMF clip art images free when you purchase Jasc Media Center.

Related Topics:
         Jasc Products  



BUDGETWARE (Australia)
To print this form, click on the Print Button above, or press <Alt> + <P>.
You can order from BUDGETWARE by payment with check or credit card. The credit cards 
accepted are: MC, Visa, or Bankcard. The numbers for ordering are: (02) 519-4233, FAX: (02)
516-4236 International Numbers: +61 2 519-4233, FAX: +61 2 516-4236 (THESE NUMBERS 
ARE FOR PLACING AN ORDER ONLY!) 
Please use this form when ordering by mail.

NAME
COMPANY
ADDRESS
ADDRESS
TOWN
CITY
COUNTRY POST CODE
TELEPHONE NUMBER
CREDIT CARD TYPE EXPIRATION DATE
CREDIT CARD NUMBER

Jasc Media Center $69.00 Australian ________
Paint Shop Pro $110.00 Australian ________
Paint Shop Pro & Media Center $149.00 Australian ________
Shipping/Handling (Outside of Austrailia)$15.00 Australian ________
TOTAL ________

Make cheques payable to BUDGETWARE. Mail to:
BUDGETWARE
P.O. Box 496
Newtown NSW 2042
Australia



PRO SOFT (Danmark)
To print this form, click on the Print Button above, or press <Alt> + <P>.
Modtager registreringer fra Danmark, Norge, Sverige og Finland.

Navn:
Evt. Firma:
Adresse:
Adresse:
Postnr.:
By:
Telefon:

Disk Size prefered    3.5"_________    5.25"__________

Danmark
:

Norge,
Sverige 

& Finland:
Jasc Media Center 320,00

kr
320,00 kr

Paint Shop Pro 578,00
kr

578,00 kr

Paint Shop Pro & Media 
Center

738,00
kr

738,00 kr

Forsendelse 20,00 kr
Forsendelse incl. opkrav. 50,00 kr.
MOMS (p.t 25%) ______ kr
Total ______ kr ______ kr

Betaling: Sendes til:
[ ] Giro 4 06 21 40
[ ] Giro-Bon
[ ] Check
[ ] Opkrav I Danmark + 22,50 kr.

Pro-Soft
Benloese Skel 4 G
DK-4100 Ringsted
Danmark
Tlf.: (+45) 53 61 90 
42
Fax.: (+45) 53 61 93 
91



Digital Workshop (England) 
To print this form, click on the Print Button above, or press <Alt> + <P>.
You can order from Digital Workshop by payment with cheque or credit card (American 
Express, MasterCard and Visa). The numbers for ordering are: Voice (0295) 258335 or FAX 
(0295) 254590

Order Form
NAME
COMPANY
ADDRESS
ADDRESS
TOWN
CITY
COUNTRY POST CODE
TELEPHONE 
CREDIT CARD TYPE EXPIRATION DATE
CREDIT CARD NUMBER
SIGNATURE

Product: Cost: # of
Copies:

Product
Total:

Jasc Media Center £ 29.95 ______ £ _________
Paint Shop Pro £ 49.95 ______ £ _________
Paint Shop Pro and Jasc Media Center £ 64.95 ______ £ _________
VAT (EC residents) @ 17.5% ______ £ _________
Shipping/Handling £ 2.50 £ _________
Total £ _________

***The prices here are discounted off the suggested retail price.    This discount is in 
recognition that our shareware users should enjoy the savings we all enjoy in the cost of the 
software.

Make cheques payable
to:

Digital Workshop

Mail to: Digital Workshop
First Floor, 8 West Bar
Banbury, Oxon
OX16 9RP England

WindowShare (France)
Il faut claquer le bouton "Print" au dessus pour imprimer cette fiche.
To print this form, click on the Print Button above, or press <Alt> + <P>.

** Paint Shop Pro & Jasc Media Center ** 
LICENCE d'UTILISATION



Les sociétés peuvent nous consulter pour des licences multipostes (sur site) ou des licences multiples.
Remplacez le soulignement par les renseignements demandés. 

Imprimez cette fiche, et adressez le tout avec votre règlement à :
WindowShare SARL
B.P. 2078
57051-METZ cedex 2
France

Fax : (+33)87 32 37 75
Vox : (+33)87 30 85 57
Minitel : 3615 WinShare
(boutique LICENSEWARE)

Nom et Prénom:
Adresse:

Code Postal et Ville:
Paint Shop Pro est désormais livré avec 30 images de qualité professionnelle au format JPEG.
Jasc Media Center est livré avec 100 images de qualité professionnelle au format WMF.

Quantité Nom du produit Prix Unitaire
H.T.

Prix Unitaire
TTC

Total Produit

________ Paint Shop Pro 420.75 FF 499 FF ___________
________ Jasc Media Center 252.10 FF 299 FF ___________
________ Paint Shop Pro & Jasc Media 

Center
547.20 FF 649 FF ___________

Port 00 
Total Général ___________

Disquette 3 1/2" uniquement. * Ci-joint mon règlement de __________ FF TTC, paiement par 
chèque, Eurochèque, mandat-lettre, ou carte bancaire. (* barrer la mention inutile) Carte 
bancaire, donnez les 16 chiffres, la date d'expiration et signez :
________ ________ ________ ________ Exp. : ________ /________ 
Date ________________ Signature : __________________________________

Merci de respecter le principe du shareware.



BroCo Software (Nederland)
Selecteer "Bestand-Onderwerp afdrukken" vanaf de menubalk om dit formulier te printen.
To print this form, click on the Print Button above, or press <Alt> + <P>.
Betalingen aan BroCo software zijn te voldoen d.m.v. Eurocheque / postcheque, bank, giro, 
en EuroCard / Mastercard.
Voor telefonische bestellingen: 02155-26650 (orderlijn) of 02155-14012 (FAX)
Gebruik A.U.B. dit orderformulier bij schriftelijke bestellingen.

NAAM
BEDRIJFSNAAM
ADRES
POSTCODE
PLAATS
TELEFOON
CREDIT CARD NUMMER
VERVALDATUM

DISKETTE FORMAAT: ALLEEN OP 3.5" LEVERBAAR

Jasc Media Center F119,00
Paint Shop Pro F169,00
PSP & MC Bundle F225,00
Verzendkosten bij vooruitbetaling F 7,50
Verzendkosten onder rembours F 12,50

** Houdt: u er rekening mee dat de aanschaf van een geregistreerde versie in bijvoorbeeld 
de Verenigde Staten vaak duurder uitvalt dan in eerste instantie mag worden verwacht 
( door BTW toeslag en hoge verzendkosten ).
Stel Eurocheque of Postcheque t.n.v. BroCo software, vergeet niet uw pasnummer te 
vermelden!
Zend dit formulier aan:

BroCo Software
Postbus 446
3760 AK SOEST
Nederland



Personal Data Factory (Japan)
To print this form, click on the Print Button above, or press <Alt> + <P>.
You can order from Personal Data Factory by payment with check.

NAME
COMPANY
STREET
STREET
CITY
STATE ZIP
COUNTRY TELEPHONE 

Disk Size prefered    3.5"_________    5.25"__________

Product: Cost: # of
Copies:

Product
Total:

Jasc Media Center ¥ 7,000 ______ ¥ _________
Paint Shop Pro ¥

15,000
______ ¥ _________

Paint Shop Pro & Jasc Media 
Center

¥
18,500

______ ¥ _________

Total: ¥ _________

Make cheques payable
to:

Personal Data Factory

Mail to: Personal Data Factory
Shimoueki-cho 451-3,
Isesaki-shi, Gunma-ken,
372 JAPAN.

JASC, Inc. (USA)
To print this form, click on the Print Button above, or press <Alt> + <P>.
You can order from JASC, Inc. by payment with check or credit card (MasterCard and Visa). 
The numbers for ordering are: 1-800-622-2793 or Voice (612) 930-9171 or FAX (612) 930-
9172

NAME
COMPANY
STREET
STREET
CITY
STATE ZIP
COUNTRY TELEPHONE 
CREDIT CARD TYPE EXPIRATION DATE



CREDIT CARD NUMBER
SIGNATURE

Disk Size prefered    3.5"_________    5.25"__________

Product: Cost: # of
Copies:

Product
Total:

Jasc Media Center $ 39.00 ______ $ _________
Paint Shop Pro $ 69.00 ______ $ _________
Paint Shop Pro & Jasc Media Center $ 89.00 ______ $ _________
Minnesota residents add 6.5% sales tax $ _________
Shipping/Handling - US or Canada $ 5.00 $ _________
Shipping/Handling - Outside of US or 
Canada

$16.00 $ _________

Total in US Funds drawn on a US Bank $ _________

Make checks payable to: JASC, Inc.
Mail to: JASC, Inc.

10901 Red Circle Drive, Suite 
340
Minnetonka, MN 55343    USA



Verlag Gisela Lakies (Deutschland)
To print this form, click on the Print Button above, or press <Alt> + <P>.
In Deutschland, Österreich und der Schweiz wird eine deutsche Version von Paint Shop Pro 
und von Jasc Media Center als    Standardsoftware mit deutschsprachigen Handbüchern 
angeboten. Das Handbuch enthält wichtige Informationen und Tabellen, die zur Nutzung der 
gesamten Leistungsfähigkeit von Paint Shop Pro oder Jasc Media Center unentbehrlich sind.

Im Kaufpreis ist die kostenlose Benutzung der Supporthotline bei auftretenden Problemen 
enthalten. Bestellungen können per Verrechnungsscheck, VISA-Card, Kreditkarte oder nach 
tel. Absprache per Nachnahme oder Rechnung erfolgen. Bezugsadresse (auch für Händler):

Verlag Gisela Lakies Tel. 05864 / 1328
Dobro 14 Fax 05864 / 1312
D-29479 Jameln CompuServe 70007,5504

Bestellung
Anz.                 Ges.-Preis
___ Paint Shop Pro (englische Version)         95,00 DM        ______ DM
___ Paint Shop Pro (deutsche Version) 145,00 DM        ______ DM
___ Jasc Media Center (englische Version)     65,00 DM        ______ DM
___ Jasc Media Center (deutsch)     85,00 DM        ______ DM
___ Paint Shop Pro und Jasc Media Center (engl.) 140,00 DM        ______ DM
___ Paint Shop Pro und Jasc Media Center (dtsch.) 185,00 DM        ______ DM

Summe                 ______ DM
Versandpauschale 8,00 DM

Mehrwertsteuer (15 %)                 ______ DM

Rechnungsbetrag                 ______ DM

Firma: ____________________________________________________

Name: ____________________________________________________

Straße: ___________________________________________________

PLZ, Ort: __________________________________________________

Tel.:____________________ Telefax: ___________________________

Kreditkarte:                    O    VISA                              O    Eurocard / Mastercard

Nummer der Kreditkarte: ______________________________________

Gültig bis: _______    Kreditinstitut: _______________________________

______________ , den ___________                ________________________
                  Datum                                                                                                                      Unterschrift





SECTION: Products



Jasc Products
If you are interested in any of our products, please contact one of our vendors. 
Developed by Jasc:

         Paint Shop Pro  
         Jasc Media Center  
         Professional Capture Systems  

Distributed by Jasc:
         SkyMap  
         CDPlayer  
         Illuminatus  

Related Topics:
         Purchasing Jasc Products  



Paint Shop Pro
Paint Shop Pro is a powerful Windows graphics program that provides Painting, Photo 
Retouching, Image Enhancement, Editing and Color Enhancement functions. An Image 
Browser, Batch Image Conversion, Image Viewing and Printing, Screen Capture and 
Scanner Support (TWAIN Complient) are also provided. Enhance your other applications 
with Paint Shop Pros OLE support.
Painting
You can use one of 8 different brushes including pen, pencil, marker, crayon, chalk, 
charcoal, airbrush, and paintbrush to edit an existing or create your own images. A user 
defined brush allows you to combine elements of any of the other brushes to create a 
unique effect, while the fill tool allows easy filling of large areas. No need to worry about 
errors since the undo brush allows mistakes to be easily corrected. Other features include: 

Color replacer brush allows easy replacement of one color with another.
Filled and hollow rectangle and oval tools allow simple creation of objects.
Variable width line tool allows for quick creation of lines.
Text tool allows high quality anti-aliased type to be added to images.

Photo Retouching
Work on existing images with the clone brush for easy duplication of image areas, or with 
the magic wand for quick selection of similar areas for manipulation. Paint Shop Pro also 
provides a push brush for easy touch-up, a sharpen brush to enhance detail in small areas, 
and a smooth brush for easy blending. You can also use the eye dropper to pick up and 
analyze a color from an image.
Image Enhancement and Editing
Paint Shop Pro allows you to perform flip, mirror, rotate (by 1 degree increments), and crop 
operations, plus the ability to add borders and frames, or resize and resample your image. 
Paint Shop Pro ships with 20 standard image filters plus any user definable filters you 
create. Also included are 12 image deformations, including skew and circle. Paint Shop Pro 
also includes filter and deformation browsers to allow quick previews of their effects. 
Additional functions include: 

Support for 3rd party plug-in filters. 
All effects may be applied to a selected area.
Paste functions allow sections of one image to be placed into any other.

Color Enhancement
You can use Paint Shop Pro to alter the hue, saturation, lightness and RGB levels. 
Adjustments to brightness and contrast and changes to highlight, shadow, and midtone 
can also be made. Palette editing and direct palette mapping allowing global changes to 
multiple images are also available. Gamma correction and color reduction are also 
provided. Other features include:

Colorize to add overall hue to greyscale images.
Histogram to aid in color adjustments.
Color enhancements may be made to selected areas (24 bit images only).

Image Browser
The browser, using thumbnails, allows you to visually search directories for those easy to 
lose images. The thumbnails may optionally be saved to specific directories for super-quick 
access. You can select multiple images to be loaded directly into Paint Shop Pro for editing. 
Complete file management functions allow you to easily keep track of images. 
Batch Conversion
When it comes to converting a large number of images from one format to another, Paint 
Shop Pro has made it as easy as possible. All messages during the conversion are sent to 
the log window for unattended operation, and the log may be saved to a file for later 



inspection.
Supported File Formats
BMP/DIB/RLE (Windows), BMP/DIB (OS/2), *CDR, *CGM, CLP, CUT, *DRW, *DXF, EPS (Write 
Only), GIF/RLE, *GEM, *HGL, IFF, IMG, JIF/JPG, LBM, MAC, MSP, *PCD (Kodak Photo CD), PCX,
*PIC (Lotus), PIC, PBM/PGM/PPM, PSD, RAW, RAS, TIF, TGA, WMF, WPG (Bitmap), *WPG 
(Vector).

* = Read Only
Winner of the Following Awards:

Shareware Magazine Editor's Choice
Winner of the Shareware Industry Awards - Best Graphics Application
Winner of the Ziff Davis Shareware Awards - Graphics

Special Offer!
When you purchase Paint Shop Pro, you can purchase Jasc Media Center at a reduced price.

Related Topics:
         Jasc Products  
         Purchasing  



Professional Capture Systems
Professional Capture Systems (PCS) allows you to do screen capturing under both Windows 
and DOS.
The Windows program, JasCapture, allows you to capture a defined area, the full screen, a 
window, a client area, an object, or a predefined size. The capture can be sent to any 
combination of the clipboard, printer, and disk. Captures can be saved to BMP, PCX or TIFF. 
Requires Windows 3.1 or later.
The DOS program, DosCapture, allows you to capture standard and extended VGA text 
modes and standard VGA graphics modes. Captures are saved to PCX files. DosCapture 
requires a 286 processor or better and VGA.
Winner: Shareware Magazine Editor's Choice

Related Topics:
         Jasc Products  
         Purchasing  



Jasc Media Center
Jasc Media Center is designed to be your command center for multimedia file management
and manipulation. It contains all the commands you need to manage your multimedia files.
Features include:

Organizing your multimedia files into albums. Arrange the thumbnails using drag and 
drop or one of many sorting options.

Catalog multimedia files using keywords and comments for future searches.
Scan for all the files on your system to hunt down those unneeded, space wasting 

files.
View your images full screen or in a configurable slide show.
Use the slide show option to create transition effects, play an audio CD in the 

background and associate WAV files with images.
Activate your favorite editor to edit the files.
Print your album as a catalog.
Support for 30 different multimedia file formats.
Convert your image file to another format.
Files of an album may come from different directories and different drives. Special 

support for removable disks and CD Roms allows you to track your multimedia files and have
Jasc Media Center tell you which disk you need.

Move, Copy, or Rename the original multimedia file.
Winner: Shareware Magazine Editor's Choice
Special Offer!
When you purchase Paint Shop Pro, you can purchase Jasc Media Center at a reduced price.

Related Topics:
         Jasc Products  
         Purchasing  



SkyMap
SkyMap is a highly accurate "planetarium" for Windows 3.1. It can draw a map of the sky, 
as seen from any place on Earth, for any date between 4000 BC and 8000 AD, displaying 
stars, planets, comets, deep-sky objects, constellation names and figures, and a whole lot 
more. Detailed information about any object on a map can be obtained simply by clicking 
on it with the mouse, and high quality charts can be printed on any printer supported by 
Windows. Pictures of objects, in several formats, can be associated with objects and 
displayed, either manually or automatically.

Related Topics:
         Jasc Products  
         Purchasing  



CDPlayer
CDPlayer is an audio CD playing program for Windows and DOS that provides even more 
functions than a home CD player, including the ability to catalogue and browse through 
your CD collection. CDPlayer's features include:

Custom program play
Single track play
Shuffle play
Repeat on any play function
Fit tracks to time (for tape recording)
Track skip
Music search
Replay track
Pause
On screen volume and balance - either using CDPlayer's
Internal dialogue or running your soundcard mixer program.
Multiple CD ROM support
Disc catalogue allowing the storage of the following for each disc: disc name, 

composer/artist, music type, disc reference, individual track details, word-search browsing 
On screen display of elapsed and remaining time for both the current track and the 

disc

Related Topics:
         Jasc Products  
         Purchasing  



Illuminatus
Illuminatus is an impressive new program offering an alternative to both business 
presentation packages and complex multimedia authoring tools. Illuminatus is a 
multimedia publisher that works like a frame-based DTP package. Illuminatus produces a 
standalone interactive multimedia publication which you can publish and distribute on CD 
or floppy disk. Quickly and easily combine words, pictures, video, animation and sound into
exciting interactive multimedia publications of all kinds and publish them on floppy disk or 
CD Rom. NO PROGRAMMING! NO ROYALTIES!
Features Include:

Page Options - Double click on your page to edit...
Background color or picture.
Timing - control how long the page stays in view.
Display - control the special effects to bring your page on or take it off again.
Frame Options - Fill your frames with...
Background color or picture.
Slideshows.
Animation.
Video.
Text.
and add a border.
Button Options - Program your masterpiece simply by setting the options you need...
Close the publication.
Go to another page.
Run an animation, video or slideshow (and/or stop one).
Play a sound (or stop one).
Launch a program or extension.
Store text on disk (for recording scores/progress etc.).
Make the button invisible to act as a hot spot.
Publication Options
Choose how your publication can be interrupted and protect it with a password to 
prevent unauthorized closedown. Also choose how your publication closes.
Installation Options
Select the size of disk your publication will be distributed on and Illuminatus will 
divide it up accordingly. Choose an icon for your program, the default directory for 
your user to store it in and what your publication will be called.
Slideshows
Create onscreen slideshows of any size from your graphics files using any special 
effects at your own speed. You can even create simple animations, message boxes, 
and text effects with this feature.
Background Music and Voice Overs
You can launch music or sound from any page. Narration can play over the op of 
music and you can use a simple delay option to synchronize events.
Special Effects
Cut, Horizontal Blinds, Explode, Swirl In, Swirl Out, Slide Up, Slide Down, Slide Left, 
Slide Right, Blocks.
Formats - Illuminatus Supports...
BMP, PCX, WMF, CGM, TIF, TGA, GIF, JPG, WPG



WAV, MID, RMI
AVI, FLC, FLI
Illuminatus is ideal for creating...
Interactive Encyclopedias
Disk-based (or CD-ROM) Catalogs
Computer Based Training
Demos for Shows and Shops
Electronic Brochures
On-line Books
Multimedia Presentations
Interactive Entertainment
Digital Newsletters

Related Topics:
         Jasc Products  
         Purchasing  



 




